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Kas yra duomenų bazė? 

Paprasčiausia duomenų bazė – tai duomenimis užpildyta lentelė. Jeigu paprastą lentelę, parašytą 

popieriaus lape, įvesite į kompiuterį, turėsite kompiuterizuotą lentelę, arba paprasčiausią 

kompiuterizuotą duomenų bazę. Iš vienos lentelės kompiuteris galės pateikti kitokios formos, su kitaip 

išdėstytais duomenimis kitas lenteles arba tos pačios lentelės ne visas eilutes arba ne visus stulpelius. Be 

to, jei norėsite, galės įvairiai surūšiuoti duomenis, apskaičiuoti rezultatus arba nubraižyti diagramas. Jei 

reikės, sukeis eilutes ir stulpelius vietomis, atnaujins arba papildys duomenis ir t. t. Dažniausiai 

duomenų bazę sudaro kelios lentelės. Jos duomenų bazėje gali būti įvairiai jungiamos ir pertvarkomos. 

Iš pradinių lentelių sukuriamos kitos lentelės ir t. t. Kompiuteris galės surasti ir išrinkti reikalingus 

duomenis, pateikti juos ekrane arba atspausdinti popieriuje. 

Duomenų bazė – tai tam tikros informacijos (duomenų) susistemintas rinkinys. Keli pavyzdžiai, kurie 

susisteminti galėtų būti duomenų bazėmis: jūsų kontaktų sąrašas, klubo narių sąrašas, sandėlio atsargos, 

jūsų asmeninė biblioteka ir kt. 

Accesso duomenų bazė sudaroma iš skirtingų objektų. Svarbiausias duomenų bazės objektas yra 

lentelės. Šiose lentelėse laikomi visi į duomenų bazę įvedami duomenys. Lentelė suskirstyta į stulpelius 

ir eilutes. Duomenų bazėse dažnai viena eilutė vadinama vienu duomenų įrašu, o stulpelis – duomenų 

lauku. Kiekvienas laukas turi savo pavadinimą, pavyzdžiui, Pavardė arba Adresas. Iš lauko pavadinimo 

paprastai galima spėti, kokio tipo duomenys jame rašomi. Duomenų įrašas (lentelės eilutė) paprastai 

susideda iš skirtingų laukų duomenų, pvz., apie vieną iš jūsų kontaktų, t.y. visi įvairūs duomenys apie 

vieną iš jūsų draugų. Lentelė yra bazinis objektas. Kiti objektai yra išvestiniai ir gali būti sudaromi, kai 

sukurta bent viena lentelė. 

Programa Acess skirta ne tik duomenims laikyti, bet gali ir juos apdoroti, todėl ji vadinama duomenų 

bazių valdymo programa. Ji gali duomenis atrinkti, rūšiuoti ir pateikti įvairiausiais būdais. Tam joje yra 

kelių tipų objektai: užklausos (querry), formos (form) ir ataskaitos (report). Šių terminų paaiškinimui 

apžvelgsime duomenų baz+ę, kurioje surinkta informacija apie organizacijos narius. 

Forma naudojama duomenims į duomenų bazę įvesti, keisti arba jiems ieškoti. Informacijos apie narį 

suvedimui sukuriama forma. Duomenų bazės formos pavyzdys gali būti toks – langas, į kurį 

patalpiname laukelius, skirtus reikalingai informacijai apie organizacijos narį įvesti. 

Su užklausa ieškomi, atrenkami ir analizuojami duomenys. Joje nustatomi duomenų paieškos kriterijai. 

Užklausos pavyzdžiai: kurie nariai gyvena tam tikrame mieste? Kurie nariai nesumokėjo šio mėnesio 

nario mokesčio? Kurie nariai žaidžia badmintoną? 

Ataskaitos susikuriamos tam, kad būtų galima sparčiai ir dailiai išspausdinti popieriuje iš duomenų 

bazės išrinktus ir surūšiuotus duomenis. Keli ataskaitų pavyzdžiai: telefono numerių sąrašas visiems 

klubo nariams. Sportinės veiklos aprašas ir įmokos pagal kiekvieną sporto šaką. 
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Duomenų bazės kuriamos konkrečių uždavinių poreikiams taip, kad jas būtų lengva tvarkyti, užpildyti 

duomenimis, panaudoti uždavinių sprendimo programose. Duomenų bazės kūrimas pradedamas nuo 

aplinkos, kurioje renkami pradiniai duomenys ir naudojami uždavinių sprendimo rezultatai, 

informacijos modelio sudarymo. Aiškinamasi, kaip aplinką galima skaidyti į mažesnius elementus, kaip 

aprašyti tokius elementus, jų savybes ir sąveiką bei sprendžiama daugybė kitų panašaus pobūdžio 

uždavinių. Informacijos modelių sudarymui vartojamos įvairios priemonės: žodiniai aprašymai, lentelės, 

grafinės diagramos ir kt. Vienas populiariausių yra „objektų – sąryšių“ modelis, kuriame naudojamos 

sąvokos artimos mūsų kasdieninėje veikloje vartojamoms sąvokoms. Pagrindiniai aprašomos aplinkos 

informacijos modelių elementai šiame modelyje yra objektai, jų atributai ir sąryšiai.  

Informacijos objektas arba esybė (entity) yra aprašomas aplinkos elementas, apie kurį pageidaujama 

laikyti informaciją. Išskiriant atskirus objektus, vadovaujamasi tiek natūraliomis dalykinės srities 

savybėmis, tiek duomenų apdorojimo poreikiais. Pavyzdžiui, įstaigos dirbančiųjų aprašymo objektas 

darbuotojas yra natūralus kiekvienos įstaigos informacijos modelio elementas, tačiau kartais jį naudinga 

skaidyti į smulkesnius objektus. Jei darbuotojų adresai ir duomenys apie jų kvalifikaciją daugumoje 

įstaigoje sprendžiamų uždavinių nenaudojami, juos įtraukti į pagrindinį darbuotojų savybių aprašymą 

nenaudinga. Geriau sudaryti supaprastintą pagrindinį darbuotojų aprašymą ir jame įterpti nuorodas į 

atskirai laikomus kvalifikacijų ir adresų aprašymus. Tada sakysime, kad pagrindinis objektas darbuotojas 

turi jam pavaldžius pagalbinės informacijos objektus apie jų kvalifikaciją ir adresus. 

Kiekvienas informacijos objektas apibūdinamas unikaliu savybių (atributų) rinkiniu, o tokio rinkinio 

reikšmė vadinama įrašu. Atskiroms objekto savybėms aprašyti skirtos įrašo dalys vadinamos laukais. 

Kiekviena objekto savybė turi pavadinimą (pavyzdžiui, spalva, svoris) ir jai būdingą reikšmių aibę. 

Griežto skirtumo tarp savybės ir objekto ir objekto sąvokų nėra. Tam tikrame kontekste atskiras 

atributas gali tapti tipu. Pavyzdžiui, automobiliui spalva yra savybė, o, nagrinėjant dažų gamybos 

technologiją, tai gali būti savarankiškas informacijos objektas. 

Loginiai duomenų bazių sandaros modeliai nurodo, kaip yra sudaromi objektų reikšmių (įrašų) laikymo 

kompiuterio atmintyje dariniai. Naudojami keturi pagrindiniai loginės sandaros modeliai: hierarchnis, 

tinklo, objektinis ir sąsajinis (reliacinis). 

Hierarchiniame modelyje kiekvienas įrašomas sudaromas iš dviejų elementų: pirminio rakto, kuris 

vienareikšmiškai identifikuoja įrašą, ir jam pavaldžių laukų rinkinio, kur laikomi kiti objekto atributai. 

Ryšius tarp įrašų aprašo specialūs laukai – nuorodos. Kiekvienas įrašas hierarchinėje struktūroje gali 

turėti daug nuorodų į jam pavaldžius įrašus ir tik vieną nuorodą iš valdančio (esančio aukštesniame 

hierarchijos lygyje) įrašo. Toks ryšių nurodymo būdas atitinka sąryšį „vienas su daugeliu“. Pagrindinis 

hierarchinių sistemų trūkumas – griežti ribojimai sąryšių aprašymo priemonėms. 

Tinklo modelis sukuria ryšius tarp nepriklausomų duomenų elementų. Tokiame modelyje kiekvienas 

įrašas gali turėti ryšių su bet kuriais kitais bazėje laikomais įrašais. Modelis leidžia realizuoti sąryšius 
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„daugelis su daugeliu“, tačiau jo realizavimas ir tvarkymas yra gana sudėtingas. 

Dabar populiariausios yra sąsajinės (reliacinės) DBVS, kuriose naudojamos gana paprastos ir nesunkiai 

įsisavinamos duomenų tvarkymo operacijos. Modelio pavadinimas yra kilęs iš anglų kalbos žodžio 

relation (sąsaja). Jis pabrėžia, kad bet kokias duomenų rinkinių priklausomybes galima apibrėžti 

lentelėmis aprašomomis sąsajomis. Lentelių tvarkymui taikomos lengvai suprantamos aibių teorijos 

operacijos: sąjunga, sankirta, skirtumas. Vartotojai tokią bazę gali įsivaizduoti kaip lentelių sistemą ir iš 

jose laikomų duomenų paprastomis operacijomis formuoti naujus darinius ir įvairias ataskaitas. 

Pavyzdys tokios DBVS – Microsoft Access. 

Objektiniuose modeliuose taikoma objektinio projektavimo metodologija. Šiame modelyje naudojami 

objektai, kuriems būdingi ne tik jų savybes aprašantys atributai, bet ir jiems taikomų veiksmų rinkiniai. 

Pavyzdžiui, tarkime, kad kompiuterio atmintyje reikia laikyti sudėtingo objekto grafinius vaizdus, jam 

būdingus garsus ir skaitinius atributus. Vaizdus gali būti pageidaujama pamatyti ekrane, garsus – išgirsti, 

o skaičius panaudoti skaičiavimuose. Tokių skirtingos prigimties duomenų tvarkymui tikslinga sudaryti 

atskirus objektus, kurie sugebėtų ne tiktai laikyti skirtingos sandaros duomenis, bet ir mokėtų parinkti 

jiems skirtingas atvaizdavimo bei tvarkymo operacijas. Objektiniuose modeliuose iš paprastos sanadros 

bazinių objektų kuriamos ištisos išvestinių objektų šeimos, paveldinčios bazinių objektų savybes. Šie 

modeliai puikiai tinka įvairiems pertvarkymams, pakeitimams, tipinių šablonų kūrimui ir panaudojimui. 

Access pradžia 

Pagrindiniai sąsajinės (reliacinės) duomenų bazės kūrimo etapai yra tokie: 

♦ 

♦ 

♦ 

♦ 

♦ 

♦ 

duomenų bazės sandaros (schemos) projektavimas, 

sąsajinio (reliacinio) modelio lentelių sukūrimas, 

ryšių tarp lentelių aprašymas, 

duomenų bazės užpildymas. 

Kaip pradėti kurti duomenų bazę? Pirmiausia, aišku, reikia 

paleisti veikti programą Access. Spragtelėkite ant Start 

mygtuko, o po to – ant išsiskleidžiančio Programs meniu. 

Programų meniu Programs yra Microsoft Access eilutė, 

spragtelėkite ant jos ir taip paleiskite programą. Ekrane 

turėtumėte matyti langą Microsoft Access, kuriame 

vartotojas gali pasirinkti ką daryti: 

savarankiškai kurti naują tuščią duomenų bazę (Blank 

Access Database); 

pasinaudoti duomenų bazių vedlio paslaugomis arba tipiniais projektais (wizards, pages and 
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projects); 

♦ atverti tvarkymui jau esančią duomenų bazės failą (open an existing database). 

Norėdami sužinoti daugiau apie skirtingus dialogo 

lango laukus, dešiniuoju pelės mygtuku bakstelėkite  kokį 

nors tekstą, pvz. Acess database wizards, pages and projects, 

tada kairiuoju pelės mygtuku – pasirodžiusį užrašą What’s 

This? (Kas tai?). atsiveria langas su išsamesniu 

paaiškinimu.  

Duomenų bazės kūrimas naudoajnt vedlį (wizard) 

Duomenų bazės kūrimo vedlys (Database Wizard) padeda kurti standartizuotas duomenų 

bazes, tinkamas įvairiais tikslais. Pasirinkę šį duomenų bazės kūrimo būdą, renkamės 

piktogarmą Contact Mnagement. Iškart paprašys įrašyti savo duomenų bazę atsidariusiame 

lange: 

Lauke Save in nurodykite kokiame 

aplanke norite išsaugoti šią duomenų 

bazę. Lauke File name (failo 

pavadinimas) pasiūlo ją pavadinti 

Contact Management1 (kontaktai). 

Sutikite spragtelėdami mygtuką Create 

(kurti). 

Ekrane atsiras pirmas vedlio dialogo 

langas. Jums tereikia perskaityti kas 

parašyta ir paspausti mygtuką Next. 

Kitame lange reikia pasirinkti kokių 

laukų jums reikia įvairiose lentelėse. 

Laukelyje Fields in the table (laukeliai 

lentelėje) pateikiamas visų galimų 

laukų sąrašas, kuriame turite pažymėti 

jums nereikalingus laukus. Kaip 

matote sąraše nepažymėtas laukas 

Home Phone (namų telefono numeris); 

pažymėkite jį. 

Spragtelėję mygtuką Next pereisite į formos kūrimo langą. Pasirinkite vieną iš siūlomų formų dizaino 
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stilių. Spragtelėkite mygtuką Next. Tada pasirinkite ataskaitos maketą. Ir vėl Next. Tada dar reikia 

pavadinti duomenų bazę. Jeigu sutinkate su siūlomu pavadinimu, spragtelėkite mygtuką Next. Pasiekėte 

paskutinį dialogo langą. Paspaudus Finish – jums bus sukurta duomenų bazė su lentelėmis, formomis 

ir ataskaitomis. Vedlys darbą baigė ir atidaromas pagrindinė forma Main Switchboard (pagrindinis 

valdymo pultas), kuris yra svarbiausia jūsų duomenų bazės valdymo priemonė. 

Dabar įrankių juostoje paspauskite mygtuką  Database Window (duomenų bazės langas). 

Duomenų bazės lango kairėje yra skirtingų objektų mygtukai: Tables (lentelės), Querries (užklausos), 

Forms (formos), Reports 

(ataskaitos), Pages (puslapiai), 

Macros (makrokomandos) ir 

Modules (moduliai). Su šiais 

mygtukais atidaromi atitinkamų 

objektų langeliai. Spragtelėkite 

kiekvieną mygtuką ir 

pasižiūrėkite, kokių objektų yra 

jūsų duomenų bazėje.  

 Iš įrankių juostos galima nustatyti, kaip išdėstyti ir rodyti objektus duomenų bazės 

lange: Large Icons (didelės piktogramos), Small Icons (Mažos piktogramos), List (sąrašas) ir Details 

(Išsamiai). 

Paspaudę formų mygtuką pamatysite visas vedlio sukurtas formas. Pasirinkę Switchboard, sugrįšite į 

naujos duomenų bazės pagrindinį valdymo pultą. Pasirinkę Enter/View Contacts – atidarysite formą 

duomenų suvedimui ir peržiūrėjimui. Čia galite suvesti duomenis. Įvesdami naujo įrašo duomenis, 

teksto žymeklį galite kilnoti iš vieno laukelio į kitą klavišais Tab arba Enter, arba spragtelėdami pele. 

Klavišais Shift+Tab grįšite į ankstesnį laukelį. Formos.  

apačioje yra penki mygtukai. Mygtukų funkcijos tokios:  pereiti į pirmą įrašą,  pereiti į ankstesnį 

įrašą,  pereiti į paskesnį įrašą,  pereiti į paskutinį įrašą,  sukurti naują įrašą.  šis laukas 

rodo aktyvaus įrašo numerį. 

Jeigu norite ištrinti kažkurį įrašą, pažymėkite jį ir paspauskite įrankių juostoje mygtuką (Delete 

Record). Atsivėrusiame lange paspauskite 

mygtuką Yes, patvirtindami, kad norite šį 

įrašą ištrinti. Dialogo langas primena, kad 

ištrinto įrašo atkurti negalima. 

Jeigu norite rasti informaciją apie kažkurį asmenį, galima naudoti komandą Find . 
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Laukelyje Find What – įrašome ko 

ieškome. Laukelyje Replace With – galime 

nurodyti kuo pakeisti surastą įrašą. 

Laukelyje Look in galima pasirinkti 

formos pavadinimą. Laukelyje Match field 

galima pasirinkti Any part of the field (bet 

kokia laukelio dalis), Whole field (visas 

laukas), Start of field (laukelio pradžia). 

Laukelyje Search (ieškoti) galima 

pasirinkti kokia kryptimi ieškoti – Up 

(aukštyn), Down (žemyn), All (visuose įrašuose). Laukelyje Match Case – tikrinti didžiųjų ir mažųjų 

raidžių atitikimą. Laukelyje Search fields as formatted – ieškoti laukų pagal tuos pačius formatus. 

Naujos tuščios duomenų bazės kūrimas 

Jeigu norite sukurti jūsų pačių suprojektuotos sandaros duomenų bazę, pasirinkite Blank Access 

database arba File/New/Database. Iškart atsidarys standartinis naujos duomenų bazės vardo ir jos 

laikymo vietos užklausos OS Windows langas.  

Duomenų bazių kūrimas pradedamas nuo lentelių sandaros aprašymo. Siūlomi trys naujų lentelių 

kūrimo būdai: 

Create table in design view – sukurti lentelę konstruktoriaus režimu; 

Create table by using wizard – sukurti lentelę naudojant vedlio siūlomą tipinių lentelių sąrašą; 

Create table by entering data – kurti lentelę įvedant duomenis, kai laukų parametrai parenkami 

automatiškai, atsižvelgiant į įvedamų duomenų savybes.  

Lentelės kūrimo būdą galima pasirinkti 

dvigubu pelės spragtelėjimu ties pasirinktu 

būdu arba pagrindinio lango įrankių juostos 

mygtuko New atveriamame lange.  

Iš penkių siūlomų variantų pasirinkite trečiąjį 

– dukart spragtelėkite ant Table Wizard 

(arba spragtelėkite ant Table Wizard, o po 

to ant mygtumo OK) ir truputį luktelėkite. 

Ekrane pasirodys dialogo langas Table 

Wizard (lentelės konstruktorius): 

Lentelių konstruktorius gali pateikti dviejų rūšių lentelių pavyzdžius: verslo poreikių ir asmeninių 

poreikių. Dialogo Table Wizard lange yra rodomas lentelių pavadinimų išplėstinis sąrašas Sample 
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Tables (lentelių pavyzdžiai). Iš šio sąrašo galima pasirinkti lentelės pavyzdį. Jų labai daug. Žemiau 

pateikiami kai kurių svarbesnių pavyzdžių pavadinimai ir trumpas aiškinimas. 

 
VERSLO POREIKIŲ LENTELIŲ PAVYZDŽIAI: 

Mailing List (adresai): visa informacija apie verslininką – vardas, pavardė, telefonai, faksas, įprastinis 

adresas ir elektroninio pašto adresai ir kita, pavyzdžiui: skolos, pomėgiai, sveikatos būklė, fotografija ir t. 

t.  

Customer (klientai, užsakovai): informacija apie vardą, pavardę, miestą, adresą, pašto indeksą, telefoną 

ir t. t. 

Employees (tarnautojai): įprastinė informacija apie firmos darbuotojus, be to, pareigos, pensijos kodas, 

draudimas, išsilavinimas, atlyginimas, mokesčiai, fotografija, sutuoktinio vardas ir t. t. 

Products (prekės): informacija apie tiekiamas prekes, tiekėją, serijinį numerį, atsargas sandėlyje, 

mažiausias atsargas, paraiškos apimtį, kainą ir t. t. 

Orders (paraiškos): paraiškos numeris, užsakovas ir jo adresas, paraiškos data ir įvykdymo data, tiekimo 

išlaidos ir t. t. 

Orders Details (paraiškų elementai): paraiška, prekė, pardavimo data, kiekis, kaina, nuolaida, mokestis, 

atsiskaitymo būdas ir kt. 

Suppliers (tiekėjas): informacija apie visus tiekėjus. 

Payments (įmokos): užsakymas, įmokos suma, data, būdas, kreditinės kortelės tipas ir numeris ir kt. 

Invoices (sąskaitos): sąskaitos numeris, būklė, data, vykdymo data, pateikimas ir kt. 

Invoice Details (sąskaitos elementai): sąskaita, užsakymas, prekė, kiekis, kaina, atsiskaitymo sąlygos, 

nuolaida. 

Events (renginiai): informacija apie įvairius renginius, vieta, renginio data ir laikas, vietų skaičius, kaina 

vienam dalyviui ir t. t. 

Students (studentai): informacija apie studentus – vardas, pavardė, adresas, telefonas, vadovas ir kt. 
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Students and Classes (studentai ir grupės): grupė, mokslo metai, moksleiviai. 

ASMENINIŲ POREIKIŲ LENTELIŲ PAVYZDŽIAI: 

Addresses (adresai): adresas, telefonas, pomėgiai, paskutinio laiško ar pokalbio data, pravardė, ir kt. 

Recipes (receptai): pavadinimas, aprašas, paruošimo laikas, kategorijos ir kt. 

Authors (autoriai): tautybė, gimimo data ir vieta, mirimo data ir kt. Ši lentelė tiktų jūsų namų 

bibliotekai. 

Books (knygos): pavadinimas, leidėjas, puslapių skaičius, pastabos ir kt.  

Dialogo lange Table Wizard yra dar vienas, kol kas dar tuščias, sąrašo laukas Fields in my new table 

(naujos lentelės laukai). Šį sąrašo lauką pildysite laukų vardais, kuriuos pasirinksite Sample Fields 

išplėstiniame sąrašo lauke. 

Nusprendę, kokią lentelę konstruktorius turi sukurti, dialogo lango kairėje įjunkite jungiklį Business 

(verslo) arba Personal (asmeninė). Lentelių pavyzdžių lauke Sample Tables pele pažymėkite tą 

lentelės pavyzdžio pavadinimą, kuris yra labiausiai tinkamas. Viduriniame lauke Sample Fields 

pasirodys pasirinktos lentelės laukų vardų sąrašas. Sample Fields lauke du kartus spragtelėkite pele ant 

pasirinkto lauko vardo, ir tas lauko vardas pasirodys Fields in my new table sąrašo lauke. Kai reikia 

įterpti naujus laukų vardus arba kai reikia iš sudaryto sąrašo vardus šalinti, galima pasinaudoti tarp 

sąrašų laukų esančiais komandų mygtukais: 

> pažymėtasis Sample Fields sąraše lauko vardas kopijuojamas į naujos lentelės sąrašo lauką; 

>> pažymėtojo lentelės pavyzdžio pavadinimo Sample Tables sąrašo lauke visi laukų vardai 

kopijuojami į naujos lentelės sąrašo lauką; 

< šalina pažymėtą lauko vardą iš Fields in my new table sąrašo; 

<< šalina visą laukų vardų sąrašą iš Fields in my new table sąrašo lauko. Tada galima pradėti rinkti 

laukų vardus iš naujo. 

Į savo naują lentelę laukų vardus tinkama tvarka galite surinkti iš įvairių lentelių pavyzdžių. 

Užduotis Nr. 1 

Sukurkime lentelę Draugai, į kurią surašysite duomenis apie savo klasę: 

1. Dialogo lango Table Wizard kairėje įjunkite jungiklį Personal (asmeninė). 

2. Spragtelėkite ant Addresses pavyzdžio Sample Tables sąraše. 

3. Iš sąrašo Sample Fields išrinkite reikalingus laukus: dukart spragtelėkite ant AddressID, 

FirstName, LastName, Address, HomePhone, Birthdate, Hobbies. Visi šie laukai atsiras 

sąraše Fields in my new table. 

4. Laukų pavadinimus reikėtų užrašyti lietuviškai. Tam spragtelėkite ant AddressID, po to 

spragtelėkite mygtuką Rename Field… Atsiradusiame dialogo lange įrašykite Eil Nr (taškų dėti 

lauko varduose programa Access neleidžia!) ir spragtelėkite ant OK. Analogiškai pakeiskite 

FirstName į Vardas, LastName į Pavardė, Address į Adresas, HomePhone į Telefono Nr, 

Parengė dėst. Danguolė Ignatavičiūtė 2003m. Access - 9 



VILNIAUS KOLEGIJA EKONOMIKOS FAKULTETAS 
Informacinės technologijos 

 
Birthdate į Gimimo data, Hobbies į Pomėgiai. 

5. Spragtelėkite ant Next. 

6. Pasirodžiusio dialogo lango 

laukelyje What do you want to 

name your table? įrašykite 

lentelės pavadinimą Draugai. 

7. Spragtelėkite ant Next. 

8. Jeigu kuriate nebe pirmą lentelę, 

pamatysite langą, kuriame 

klausiama, ar naujoji lentelė 

susieta su kuria nors kita 

lentele. Tarkime, kad ne, todėl 

spragtelėkite ant Next. (Apie lentelių sąryšius bus kalbama vėliau). 

9. Paskutiniame lange klausiama, ką norėsite daryti, kai lentelė bus baigta: keisti jos struktūrą, įvesti 

duomenis ar sukurti formą duomenims įvesti. Siūloma pasirinkti  duomenų įvedimą. Tačiau 

norėdami įvesti telefono numerį turėsite problemų. Access reikalaus, kad įvestumėte kodą, kuris 

nelabai reikalingas, nes visa 

klasė turbūt gyvena viename 

rajone, o taip pat bus prašoma 

šešiaženklio telefono numerio. 

Todėl įjunkite pasirenkamąjį 

jungiklį Modify the table 

design (keisti naujos lentelės 

struktūrą) ir spragtelėkite 

mygtuką Finish.  

10. Ekrane pasirodys naujas 

lentelės struktūros konstravimo 

langas Draugai: Table. 

Lentelės laukų parametrai 

Pasirinkus lentelės kūrimą konstruktoriaus režime, galėsime patys nurodyti lentelės sandarą. Lentelės 

sandaros aprašymo lange yra dvi skirtingos paskirties dalys: lentelės sandaros aprašymo ir laukų 

parametrų parinkimo. Lentelės sandara aprašoma specialiojoje trijų stulpelių aprašų lentelėje, o laukų 

parametrai parenkami dviejose kortelėse: General (bendrieji) ir Lookup (peržiūros). Aprašų lentelėje 

kiekvienam projektuojamos lentelės laukui skiriama atskira eilutė, kurios pirmajame langelyje įrašomas 
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lauko pavadinimas, antrajame parenkamas tipas, o 

trečiajame gali būti įrašomas trumpas paaiškinimas. 

Kortelėse General ir Lookup duomenų lauko 

didumą ir kitas parenkamas parametrų reikšmes 

nurodyti nėra būtina, nes jiems MS Access gali 

parinkti tipines reikšmes. 

DUOMENŲ LAUKŲ TIPAI 

1. Text (tekstinis). Tekstas iki 255 simbolių gali 

būti renkamas įvairiais simboliais, atskiru atveju 

– net ir skaitmenimis, jeigu su jais nenumatomi 

apskaičiavimai: telefono ar fakso numeriai, pašto indeksas ir pan. Numatytas (standartinis) lauko 

ilgis – 50 simbolių.  

2. Memo (aprašymų, pastabų, komentarų). Tinka laisvo pobūdžio tekstui iki 64000 simbolių įvesti ir 

saugoti. Tinka bendroms pastaboms, asmenų biografijoms, aprašymams.  

Text ir Memo laukų ilgį galima pakeisti. Tam reikia spragtelėti ant lauko, kurio ilgį norime pakeisti. 

Tada Field properties srityje esančiame laukelyje Field Size reikia įrašyti kitą ilgį. 

Laukelyje Format galima parinkti laukų formatą. Populiariausi du tekstinių laukų formatavimo būdai 

– 1) “Daugiau už” ženklas (>) priverčia visą laukelyje esantį tekstą “pasikelti” iki didžiųjų raidžių, 

nepriklausomai nuo to, kaip jis buvo parašytas. Access saugo duomenis taip, kaip jie buvo parašyti, 

tačiau jie matosi vien didžiosiomis raidėmis. Norėdami pasinaudoti šiuo variantu, Format langelyje 

parašykite vieną “daugiau už” ženklą. 2) “Mažiau už” ženklas (<) daro atvirkštinius dalykus, negu 

“daugiau už” ženklas.  

3. Number (skaičius). Taikomas tada, kai duomenys – skaičiai, su kuriais bus atliekamos matematinės 

operacijos. Atmainos skiriasi skaičių vaizdavimo tikslumu, leistinų reikšmių atkarpomis ir skaičių 

tipais. 

4. Currency (valiutinis). Tipas taikomas tada, kai numatomos piniginės operacijos. Fiksuoto kablelio 

skaičiai, kuriuose 15 ženklų skiriama sveikajai daliai ir 4 – trupmeninei.  

Skaitiniai ir valiutos laukai turi šešis formatus, kuriuos galima pasirinkti išsiskleidžiančiame meniu, 

esančiame Format langelyje. Norėdami nustatyti skaičiaus ar valiutos laukelio formatą, spragtelėkite 

ant Format teksto langelio, o po to – ant dešinėje jo pusėje esančios žemyn nukreiptos rodyklės. 

Kiekvieno formato pavadinimas yra kairėje meniu pusėje. Kitoje pusėje matosi to formato veikimo 

pavyzdys. 

5. Date/Time (datos/laiko). Šiuose laukeliuose saugomas laikas, data arba judviejų kombinacija. 

6. AutoNumber (automatinis skaičius). Jeigu laukui priskirtas šis tipas, tai kiekvieną kartą atliekant 

naują įrašą jis užsipildo automatiškai sudarytu numeriu, t.y. automatiškai formuojamos unikalios 
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įrašų žymėjimui skirtos skaitinės reikšmės. 

7. Yes/No (loginis). Tame lauke galima tik viena iš dviejų loginė reikšmė – Taip arba Ne. Pavyzdžiui, 

taip galima atsakyti į klausimą “Ar moksleivis gyvena kitame mieste?”. Priklausomai nuo pasirinkto 

formato, laukelyje gali būti reikšmės Yes/No (Taip/Ne), True/False (Teisinga/Klaidinga) ir 

On/Off (Įjungta/Išjungta). 

8. OLE Object (objektų įterpimo). Šis duomenų tipas leidžia įkelti įvairius objektus: piešinius, 

diagramas ir objektus, parengtus Windows aplinkoje kitomis programomis, pavyzdžiui, Winword, 

Excel ir kt. 

9. Hyperlink (hipersaito). Interneto adresai arba saitai su diskuose laikomomis bylomis. 

Trečioje grafoje Description (aprašymas) yra rašomas aiškinamasis lauko aprašas – trumpas lauko 

paaiškinimas. Description laukelyje esanti informacija įvedant duomenis atsiranda ekrano apačioje 

esančioje būsenų juostoje. Tai – automatizuotos pagalbos tekstas.  

LAUKŲ VARDAI, DIDUMAI, REIKŠMĖS, SAVYBĖS 

Laukų vardams yra mažiau ribojimų nei failų vardams. Juose gali būti ne tik raidės ir skaitmenys, bet ir 

tarpai bei daugelis specialių simbolių, išskyrus „.“, „,“, „!“, „[“, „]“. Vardai negali prasidėti tarpu, o 

didžiausias leidžiamas jų ilgis yra 64 simboliai. 

Projektuojant lentelę, tekstinių laukų didumai 

(ilgiai) nurodomi tiesiogiai parametrų kortelės 

General eilutėje Field Size (lauko didumas) arba 

jiems parenkama standartinė 50 simbolių 

reikšmė. Skaitinių laukų didumas nurodomas 

netiesiogiai parenkant jų atmainas.  

Skaitiniai laukai 

Atmaina Didumas Savybės 
Baitas (Byte) 1 baitas Sveikųjų skaičių atkarpa [0, 255] 
Sveikasis (Integer) 2 baitai Sveikųjų skaičių atkarpa [-32768, +32767] 
Dideli sveikieji 
(Long Integer) 

4 baitai Sveikųjų skaičių atkarpa [-2147483648, +2147483647] 

Dešimtainiai 
(Decimal) 

12 baitų 28 ženklų tikslumo sveikieji skaičiai 

Realusis (Single) 4 baitai Atkarpos [-3,402823E38, +3,402823E38] slankaus kablelio 
skaičiai 

Dvigubo tikslumo 
(Double) 

8 baitai Atkarpos [-1,79769313486231E308, +1,79769313486231E308] 
slankaus kablelio skaičiai 

Sisteminės žymės 
(Replication ID) 

16 baitų Unikalių sisteminių nuorodų reikšmės 

Laukų ilgiai matuojami baitais – 8 dvejetainių simbolių grupėmis. Mažiausias skaitinio lauko ilgis 

yra vienas baitas. Tokiame lauke galima rašyti tiktai natūralius atkarpos [0, 255] skaičius. Slankaus 

kablelio skaičiais vadinami skaičiai, kuriuos kompiuteris laiko atmintyje rodikline forma: m*10e 
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(m – mantisė, e – eilė). Rašant slankiojo kablelio skaičių reikšmes, priimtą sąvoką „dešimties 

laipsnis“ žymėti simboliu E: 145E5; 0,122E-03. jeigu skaitmeninio lauko tipas nenurodomas, jam 

parenkama atmaina Long Integer (dideli sveikieji skaičiai). 

Datoms ir laikui taip pat galima keisti formatus: 

General Date (bendrasis datos formatas), kurį suteikia 

sistema automatiškai, jei vartotojas nenurodo kito; 

Long Date/ Time (ilgas datos/ laiko formatas); 

Medium Date/ Time (vidutinis datos/ laiko formatas); 

Short Date/ Time (trumpas datos/ laiko formatas); 

Lauko tipui Yes/No galimi tokie formatai: True/ false (tiesa/melas), Yes/No (taip/ne), On/Off 

(įjungta/ išjungta). 

Decimal Places (dešimtainės skiltys) – nustatomas norimas skaičiaus skilčių kiekis po kablelio. Number  

ir Currency tipo laukų duomenis galima vaizduoti norimu tikslumu, t.y. parinkti matomų po kablelio 

dešimtainių skaitmenų kiekį (nuo 0 iki 15). Nutylima Decimal Places reikšmė yra Auto, kuriai esant 

Currency, Fixed, Standard ir Percent formatų skaičiai vaizduojami dviejų skaitmenų po kablelio 

tikslumu, o General – tokiu, kaip pateikiami duomenys. 

Caption (pavadinimas) – nurodomas toks lauko pavadinimas, kuris bus spausdinamas duomenų formoje 

ir ataskaitoje. Jeigu pavadinimas nenurodytas, tai jo vietą automatiškai užima lauko vardas. Įprasta, 

kad laukų vardai – trumpi žodžiai. Ataskaitose vietoj jų kartais reikia išraiškingesnių žodžių arba 

sakinių. Dėl to laukų vardai (Field Name) gali būti keičiami laukų pavadinimais (Caption). Norint lauko 

vardą keisti lauko pavadinimu, reikia eilutėje Caption klavišais surinkti pavadinimą. 

Default Value (numatytoji reikšmė) – automatiškai nustatomos iš anksto Access sistemos numatytosios 

(standartinės) reikšmės, kol vartotojas jų nepakeičia kitomis. 

Required (būtina reikšmė) – nurodoma, ar būtina įvesti duomenis į duotąjį lauką, ar jis gali likti tuščias. 

Jei pasirinksite reikšmę Yes (taip), tai negalėsite įrašyti įrašo į diską, kol neužpildysite to lauko 

duomenimis. Parinkus variantą No, lentelės įrašas bus įvestas ir nenurodžius šio lauko reikšmės. Tai 

aktualu tuomet, kai pildant DB ne visų laukų reikšmės iš anksto žinomos (jas galima įvesti vėliau). 

Allow Zero Length (leidžiamas nulinis ilgis) – taikomas tekstiniuose laukuose. Jeigu pasirinksite reikšmę 

Yes (taip), tai norėdami nurodyti, kad laukas dabartiniame įraše nenaudojamas, galėsite įvesti kabutes. 

Pavyzdžiui, tuščias laukas Telefono numeris gali reikšti, kad nežinote draugo telefono numerio. Bet jeigu 

yra įvestos kabutės, tai rodo, kad draugas neturi telefono. 

Indexed (lauko indeksavimas) – kai konstruodami lentelę duotajam laukui Indexed eilutėje nurodysite 

reikšmę Yes (taip), Access sistema sukurs lauko indeksą greitesnei įrašų paieškai bei rūšiavimui. 

Reikalui esant, galima indeksuoti ir ne vieną lauką. Indeksavimo efektyvumas išryškėja tik dirbant su 

didelės apimties duomenų bazėmis. 
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Duomenų įvedimo šablonai (Input Masks) – tai filtrai, kurie leidžia jums langelyje įrašyti tik tam tikro 

tipo duomenis. Įvedimo šablonas yra paprasčiausia simbolių seka, kuri pasako, kokio tipo duomenis 

galima įvesti į laukelį. Jei norite, kad laukelyje būtų vien skaičiai ir nė vienos raidės, įvedimo šablonas 

gali tai padaryti. Įvedimo šablonai saugomi to laukelio General kortelėje, Input Mask laukelyje. 

Įvedimo šablonai dažniausiai kuriami telefono numeriams, pašto indeksams, asmens kodams ir 

panašiai informacijai. 

Kuriant įvedimo šabloną svarbu žinoti, kokio tipo duomenis saugosite (skaičius, raides ar abu), kiek 

simbolių jums reikia ir ar jie yra būtini ar papildomi. Pavyzdžiui, mokinio namų telefono numerį gali 

sudaryti penki arba šeši skaitmenys. Vadinasi, penki skaitmenys bus privalomi, o šešto galima ir 

nerašyti. Tokiu atveju telefono numerio įvedimo šablonas atrodys taip: 000009. Nes penki 

skaitmenys yra būtini (jie vadinami privalomais ir žymimi 0), o šešto gali ir nebūti (jis vadinamas 

papildomu ir žymimas 9).  

Norėdami į šabloną įtraukti brūkšnį, pasvirusį brūkšnį ar skliaustelį, prieš jį parašykite atgal pasvirusį 

brūkšnį (\). Kad įtrauktumėte keletą simbolių, juos dėkite į kabutes, pavyzdžiui 

 \(009”)- “000009. 

Jei jūsų laukelyje yra raidžių ir norite, kad jos visada būtų parašytos didžiosiomis raidėmis, šablono 

pradžioje pridėkite “daugiau už” ženklą (>). Jei norite, kad raidės būtų mažosios, jo vietoje 

parašykite “mažiau už” (<). Privalomos raidės žymimos L, papildomos - ?. Pavyzdžiui, jei žmogaus 

paso numeris yra sudarytas iš dviejų didžiųjų raidžių ir šešių skaitmenų. Vadinasi, įvedimo šablonas 

paso numeriui įrašyti turėtų atrodyti taip: >LL000000. Koks nors kodas gali būti sudarytas iš raidžių 

ir skaitmenų, tačiau nežinome, kurioje vietoje bus raidė, kurioje – skaitmuo. Privalomos raidės arba 

skaitmenys žymimi A, o papildomi – a (būtinai mažoji). Pavyzdžiui, žinome, kad prekės kodą 

sudarys ne mažiau kaip keturi, bet nedaugiau kaip šeši skaitmenys arba raidės. Tokiu atveju įvedimo 

šablonas atrodys taip: AAAAaa. 

Įvedimo šablonų metasimboliai 

Metasimbolis Paskirtis 
0 Privalomas skaitmuo. Ženklus + ir – rašyti draudžiama. 
9 Neprivalomas skaitmuo arba tarpo simbolis. 
# Neprivalomas skaitmuo, tarpo arba skaičiaus ženklo (+, -)simbolis. 
L Privaloma raidė. 
? Neprivaloma raidė. 
A Privaloma raidė arba skaitmuo. 
a Neprivaloma raidė arba skaitmuo. 
& Privalomas bet kuris simbolis. 
C Neprivalomas bet kuris simbolis. 
. , ; : - / Skirtukai, kurių paskirtį apibrėžia OS Windows pagalbinė programa Regional 

Settings. 
< Tolimesni simboliai vaizduojami didžiosiomis raidėmis. 
> Tolimesni simboliai vaizduojami mažosiomis raidėmis. 
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Metasimbolis Paskirtis 
\ Nurodo, kad toliau įrašyta raidė turi būti įrašoma lauke. 
! Įvedamai reikšmės simboliai užpildo šabloną iš dešinės į kairę, pradedant nuo 

dešiniojo krašto. 
Įvedimo kontrolės sąlygos (Validation Rule) padeda lentelėje esančius laukelius apsaugoti nuo 

netinkamos informacijos. Jeigu bandoma įvesti netinkamus duomenis, kontrolė parodo pranešimą 

(jūs patys įrašysite (eilutėje Validation Text), kas jame bus sakoma) apie klaidą. Įvedimo kontrolė, kaip 

ir įvedimo šablonas yra savybių Field Properies srities General kortelėje. Su įvedimo kontrole 

susiję du langeliai: Validation Rule (įvedimo kontrolės taisyklė) ir Validation Text (įvedimo kontrolės 

tekstas). Ta taisyklė – tai įvedimo kontrolė, o tekstas – tai pranešimas apie klaidą, kurį Access turi 

parodyti, kai įvedami neteisingi duomenys. Įvedimo kontrolė geriausiai veikia su skaičiais, valiutos ir 

datos laukeliais. Įmanoma sukurti įvedimo kontrolę ir teksto laukeliui, tačiau šios kontrolės labai 

greitai tampa labai sudėtingos. 

Operandais gali būti: 

♦ 

♦ 

♦ 

♦ 

♦ 

Lentelių laukų vardai, kurie rašomi laužtiniuose skliausteliuose, pvz., [fakultetas]. Taip pat rašomi 

ir lentelių vardai. Lentelės vardas atskiriamas nuo lauko vardo šauktuku (!), pvz., [grupes]![fakultetas]. 

Skaičiai, pvz., 7; 8,54. 

Tekstas (rašomas tarp angliškų kabučių, pvz., “EUROPA”, “VIKO”). 

Funkcija (kitaip tariant kreipinys į funkciją, pvz., AVG(), kuri atlieka vidurkio skaičiavimą). 

Santykių išraiškos, kurių ženklai yra šie: = (lygu), > (daugiau), < (mažiau), <> (nelygu), >= 

(daugiau arba lygu), <= (mažiau arba lygu). Pvz., [grupe]=”BA01M”. 

ĮVEDIMO KONTROLĖS PAVYZDŽIAI: 

Jei norime, kad įrašomas skaičius būtų: 

1) didesnis už nulį, Validation Rule langelyje rašome: >0 

2) nelygus nuliui, rašome: <>0 

3) tarp 0 ir 100 (neįskaitytinai), rašome >0 And <100 

4) tarp 0 ir 100 (įskaitytinai), rašome >=0 And <=100 

5) mažiau už 0 arba daugiau už 100, rašome <= Or >=100 

6) “kg” Or “m” Or “vnt” Or “l” – lauko reikšmės gali būti tik viena iš reiškinyje nurodytų reikšmių: 

“kg” arba “m” arba “vnt” arba “l”. 

7) Between 10 And 100 tikrina, ar reikšmės patenka į uždaro intervalo [10, 100] ribas 

8) Like “Ruošinys” tikrina, ar Text ir Memo tipo laukų reikšmės atitinka nurodytam ruošiniui. Jam 

sudaryti naudojami šie simboliai: ? (rodo tik raidę), * (rodo vieną arba daugiau nei vieną simbolį, arba 

nerodo nieko), # (rodo vieną skaitmenį nuo 0 iki 9), [raidės] (rodo raidę, esančią sąraše raidės); 

[raidės!] (rodo raidę, nesančią sąraše raidės). Pvz., Like “K###” nurodys tekstą, kuris susideda iš 

raidės K ir trijų skaitmenų; Like “[!ABC] – bet kurį simbolį, išskyrus A, B, C. užpildant skiltį 

Parengė dėst. Danguolė Ignatavičiūtė 2003m. Access - 15 



VILNIAUS KOLEGIJA EKONOMIKOS FAKULTETAS 
Informacinės technologijos 

 
Validation Rule, galima pasinaudoti išraiškų konstruktoriumi (Expression Builder), kuris 

iškviečiamas, paspaudus mygtuką . 

Jei norime, kad įrašoma data būtų: 

1) šiandienos arba vėlesnė data, Validation Rule langelyje rašome: >= Date() 

2) šiandienos arba vėlesnė data arba tuščia, rašome: >= Date() or Is Null 

3) ankstesnė negu šiandienos data, rašome: <Date() 

4) tarp 1990 metų sausio 1 ir šiandienos (imtinai), rašome: >= #1990.01.01# and <=Date() 

Pastaba: vartodami AND nepamirškite, kad abi įvedimo kontrolės taisyklės pusės turi būti teisingos – 

tik tokiu atveju ji bus išpildyta. Jei vartojate OR, tai tam, kad visa taisyklė būtų teisinga – pakanka, 

kad viena jos pusė bus teisinga. Derindami >= ir <= pavyzdžius būkite atidūs. Labai lengva sukurti 

tokią taisyklę, kuri niekada nebus teisinga (pavyzdžiui, <=0 And >=100). 

Pasirinkę File⇒Save arba spragtelėję įrankių juostoje mygtuką. .išsaugokite naująją lentelę. 

Grįžkime prie Užduotyje Nr. 1 sukurtos lentelės. Ekrane turėtumėte matyti ją Design View režime. 

Pakoreguokite savo lentelę.  

1) Pirmiausia būtina pakeisti telefono numerio įvedimo šabloną.  

Spragtelėkite ant lauko Telefono Nr Spragtelėkite ant Input Mask Field Properties srityje. Input 

Mask langelyje įrašykite 00\-000 (jei telefono numeriai yra penkiaženkliai ir norite, kad pirmieji du 

skaitmenys būtų atskirti brūkšneliu nuo likusių trijų). 

2) Gimimo datai nustatykite įvedimo kontrolę.  

Spragtelėkite ant lauko Gimimo data. Spragtelėkite ant Validation Rule Field Properties srityje. 

Jeigu jūsų klasės mokiniai yra gimę 1983 arba 1984 metais, Validation Rule langelyje įrašykite 

>=#1983.01.01# and <=#1984.12.31# (nuo 1983 01 01 iki 1984 12 31). Spragtelėkite ant 

Validation Text. Šiame langelyje įrašykite įspėjamąjį tekstą, kurį  norite pamatyti, jei bus įvedama 

neleistina data. Pavyzdžiui, galite parašyti: Data turi būti nuo 1983 01 01 iki 1984 12 31. 

3) Nustatykite, kad pavardės būtų rodomos didžiosiomis raidėmis. 

Spragtelėkite ant lauko Pavardė Spragtelėkite ant Format Field Properties srityje. Format 

langelyje įrašykite: >. 

4) Eilės numerio ir telefono numerio laukams suteikime pavadinimus, kur po sutrumpinimų būtų 

dedami taškai (to lauko varde nebuvo galima padaryti). 

Spragtelėkite ant lauko Eil Nr Spragtelėkite ant Caption Field Properties srityje. Caption 

langelyje įrašykite: Eil. Nr. 

Spragtelėkite ant lauko Telefono Nr Spragtelėkite ant Caption Field Properties srityje. Caption 

langelyje įrašykite: Telefono Nr. (su tašku). 
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Pirminiai raktai ir indeksai 

Kiekvienai pagrindinei sąsajinės [reliacinės] duomenų bazės lentelei rekomenduojama sudaryti pirminį 

raktą (Primary Key), kuris vienareikšmiškai identifikuoja jos įrašus ir padeda išvengti pasikartojančių 

įrašų. Pagrindinėmis duomenų sandaros lentelėmis vadinamos tokios lentelės, kurios su kitomis 

lentelėmis susiejamos tiktai per pirminio rakto reikšmes. Jei lentelė niekada nebūna pagrindinė, joje 

pirminio rakto gali ir nebūti. Lentelėje redaguojamam laukui pirminio rakto požymis suteikiamas 

paspaudžiant MS Access lango įrankių juostos mygtuką  arba parenkant pagrindinio meniu komandą 

Edit/Primary Key. Požymio atsisakoma pakartotinai parenkant šias valdymo priemones. 

Pirminis raktas yra laukas ar laukų grupė, identifikuojanti kiekvieną lentelėje esantį įrašą. Jokie du įrašai 

lentelėje negali turėti tos pačios reikšmės pirminio rakto lauke. Darbuotojo identifikacinis numeris 

dažnai naudojamas kaip pirminis raktas buhalterinėse sistemose, kadangi kiekvienas darbuotojas turi jį 

turėti ir kiekvienas numeris yra vienintelis. Pirminis raktas turi būti laukas, pagal kurio reikšmę galima 

surasti pageidaujamą įrašą. 

Pirminio rakto laukas atlieka keletą užduočių. Kadangi pirminis raktas identifikuoja kiekvieną įrašą 

lentelėje, tai jis dažnai naudojamas kuriant ryšį tarp lentelių, kai visi įrašai lentelėje atitinka kitoje 

lentelėje esančius įrašus. Neesant specifinės rūšiavimo tvarkos, įrašai lentelėje rūšiuojami pagal pirminio 

rakto lauke esančias reikšmes.  

Pirminį raktą gali sudaryti vienas ar keli laukai. Daugelio laukų pirminiai raktai naudojami tuomet, kai 

reikšmė lauke, nurodytame kaip pirminis raktas, negali būti unikali. 

Access 2000 programa turi Autonumber (automatinio numeravimo) savybę, priskiriančią kiekvienam 

įrašui unikalų numerį įrašymo metu. Taigi Autonumber lauką galima naudoti kaip pirminį raktą. 

Kiekvieno pirminio rakto reikšmės duomenų bazės lentelėje yra indeksuojamos. Tai duomenų bazės 

vidiniams poreikiams skirtos skaitinės žymės, kurios paspartina duomenų paiešką ir įrašų rikiavimą. 

Iš kelių lentelės laukų galima sudaryti sudėtinį pirminį raktą. Tada, prieš paspaudžiant mygtuką Primary 

Key, juos visus reikia pažymėti. Gretimus lentelės laukus galima pažymėti pelės spragtelėjimu, kai 

nuspaustas klavišas Shift, o žymint išsisklaidžiusius laukus, laikomas nuspaustas klavišas Ctrl. 

Sudėtiniame rakte yra svarbi jo elementų seka, kurią galima pamatyti pagrindinės priemonių juostos 

mygtuko  Indexes atveriamame 

indeksų sąraše. Nuo jo priklauso įrašų 

rikiavimo tvarka. 

Indeksuoti galima ne tik pirminių raktų, 

bet ir kitų laukų reikšmes. Tai naudinga 

daryti tada, kai šie laukai yra naudojami 

duomenų paieškai ir rikiavimui, nes, 
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panaudojant indeksus, tokie veiksmai vykdomi gerokai sparčiau. 

Norint indeksuoti lentelėje pažymėto lauko reikšmes, jo kortelės General lauke Indexed reikia išskleisti 

reikšmių pasirinkimo sąrašą ir jame pasirinkti indeksavimo būdą: Yes (Duplicates OK) – leidžiamos 

pasikartojančios reikšmės indekso lauke arba Yes (No Duplicates) – pasikartojančios reikšmės 

draudžiamos. 

Lentelių sąryšiai 

Paprastai duomenų bazė turi keletą lentelių, kurios yra susietos tarpusavyje. Lentelių sąryšiai palengvina 

duomenų paiešką ir padeda sudaryti ataskaitas panaudojant kelių lentelių duomenis. Prieš formuojant 

sąryšius, MS Access lange reikia uždaryti visų lentelių langus. Kai sukuriate naują lentelę, svarbu 

suprasti, kaip ji siesis su esančiomis duomenų bazėje lentelėmis. Kad duomenys lentelėje būtų naudingi, 

turite įdiegti ją duomenų bazėje, sukurdami logines sąsajas arba ryšius (relationships) su kitomis 

lentelėmis. Ryšiai reikalingi atrenkant duomenis iš kelių lentelių ir pateikiant juos vienoje formoje, 

ataskaitoje ar užklausoje. Kai sukursite ryšį tarp konkrečių lentelių, galite jį panaudoti tam, kad 

sugretintumėte duomenis iš vienos lentelės su kitoje lentelėje esančiais duomenimis pagal lentelės sąsajų 

taisykles. 

Sukurkime duomenų bazę Biblioteka, kurioje būtų dvi lentelės – Autoriai (tegul joje bus laukai Pavardė, 

Vardas, gimimo metai, gimimo vieta). ir Kūriniai (tegul joje bus laukai autoriaus pavardė, pavadinimas, kaina, 

kiekis, leidimo metai). 

Šias lenteles galima susieti sąryšiu, kuris nusakys, kokias knygas yra parašęs autorius. Susiejant šias 

lenteles nebereikia saugoti informacijos apie autorių lentelėje Kūriniai. 

Yra trijų tipų lentelių sąryšiai: 

1) Vienas su vienu. Vienas įrašas pirmoje lentelėje jungiamas tik su vienu įrašu antroje lentelėje. Tai 

paprasčiausi sąryšiai, bet jie retai naudojami.  

2) Vienas su daug. Vienas įrašas pirmoje lentelėje jungiasi su daug įrašų antroje lentelėje. Pavyzdyje 

apie autorius ir knygas kalbama būtent apie šio tipo sąryšį. Vienas autorius būna parašęs daug 

knygų. 

3) Daug su daug. Daug įrašų vienoje lentelėje jungiasi su daug įrašų kitoje lentelėje.  

Sujungti galima tik lenteles, esančias toje pačioje duomenų bazėje. Dažniausiai naudojamas vienas-su-

daugeliu (one-to-many) ryšys, kai vienas įrašas vienoje lentelėje gali būti susijęs su daugeliu kitoje 

lentelėje esančių įrašų. Vienas-su-daugeliu tipo ryšyje lentelė „vieno” pusėje vadinama pirmine lentele 

(primary table), o lentelė „daugelio” pusėje vadinama susietąja lentele (related table). Pirminė lentelė 

gali turėti daugelį susijusių įrašų susietoje lentelėje. Ryšys tarp jų sukuriamas nustatant sąsają tarp 

pirminio rakto, esančio laukelio pirminėje lentelėje ir vadinamojo išorinio rakto (foreign key) laukelio 

susijusioje lentelėje.  
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Rečiau naudojamas vienas su vienu (one-to-one) ryšyje vienas įrašas pirminėje lentelėje gali turėti tik 

vieną atitinkantį įrašą susijusioje lentelėje. 

Access 2000 programoje, naudojant tam tikrą taisyklių sistemą, kuriamas sąsajų vientisumas (referential 

integrity) tarp lentelių taip užtikrinant, jog įrašų tarpusavio ryšiai susietose lentelėse yra pagrįsti, ir jog 

jūs atsitiktinai neištrinsite ar nepakeisite susijusių duomenų. Sąsajų vientisumas uždraudžia bet kokius 

pirminės lentelės pakeitimus, kurie susijusios lentelės įrašus padarytų negaliojančiais. Sąsajų vientisumas 

taip pat apsaugo susijusių įrašų, kurie neturi atitinkamo pirminio įrašo įvedimą. Pavyzdžiui, negalima 

įvesti užsakymo klientui, kurio nėra duomenų banke. Įrašas be jį atitinkančio pirminio įrašo vadinamas 

našlaičiu (orphan). 

Kai jau sukūrėte ryšį tarp dviejų lentelių, nebegalite keisti ar panaikinti laukų, kuriais pagrįstas tarpusavio 

ryšys, prieš tai nepanaikinę paties ryšio. Kryptis, kuria perkelsite pirminio rakto laukelį lemia, kuri lentelė 

taps pirmine, o kuri susietoji. Lentelė, iš kurios laukelį iškelsite, visuomet laikoma pirmine, o lentelė, į 

kurią įkeliate, laikoma susietąja. 

Nagrinėjamu atveju reikės sąryšio  vienas su daug, nes vienas autorius bus parašęs daug knygų. 

Norėdami sukurti sąryšį tarp dviejų lentelių, duomenų bazės organizavimo lange pasirinkite 

Tool⇒Relationships arba spragtelėkite ant įrankių juostoje esančio santykių mygtuko  

Sąryšis mūsų duomenų bazėje kuriamas pirmą kartą, todėl ekrane pasirodys dialogo langas 

Show Table, kuriame bus aktyvioje duomenų bazėje esančių lentelių sąrašas. Jeigu būtų jau sukurtų 

sąryšių, tai šį dialogo langą reikėtų iškviesti pasirenkant komandą Relationships⇒Show Table.  

 
Spragtelėkite ant lentelės, kuri turi būti susieta sąryšiais, o po to – ant Add. Nagrinėjamu atveju turime 

tik dvi lenteles ir abi bus susietos. Todėl reikia spragtelėti ant lentelės Autoriai, po to – ant Add, 

pamatysite mažą langelį, kuriame bus išvardinti lentelėje Autoriai esantys laukeliai. Spragtelėkite ant 

lentelės Knygos, po to – ant Add. Atsiras dar vienas mažas langelis, kuriame bus išvardinti lentelėje 

Knygos esantys laukeliai. Spragtelėkite ant  Close.  
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Nustatykite pelės žymeklį ties lentelės  Autoriai laukeliu Pavardė, ir nuspauskite kairįjį pelės klavišą 

(lentelė Autoriai bus laikoma pagrindine). Laikydami pelės klavišą nuspaustą, nuveskite žymeklį iki 

lentelės Kūriniai laukelio Autoriaus pavardė (lentelė Kūriniai bus laikoma priklausomąja). Žymeklis pavirs 

stačiakampiu. Kai tas stačiakampis atsidurs ties laukeliu Autoriaus pavardė, atleiskite pelės klavišą. Ekrane 

pasirodys langelis Relationships: 

Patartina įjungti apatinėje dialogo lango 

Relationships dalyje esantį jungiklį Enforce 

Referential Integrity, skirtą lentelių sąryšių 

vientisumui palaikyti. Įjungus šį jungiklį, 

priklausomojoje lentelėje nebus galima įrašyti 

knygos, kurios autoriaus nėra Autorių 

lentelėje.  

Jeigu įjungsite jungiklius Cascade Update 

Related Fields (kaskadinis susietų laukų 

atnaujinimas) ir Cascade Delete Related Records 

(kaskadinis susietų laukų šalinimas). Jeigu šie jungikliai 

įjungti, tai keičiant arba šalinant pagrindinės lentelės 

duomenų įrašus kartu bus keičiami ir šalinami susieti 

su jais priklausomos lentelės įrašai. 

Sąryšis bus sukurtas, kai spragtelėsite ant mygtuko Create. Ryšys bus pavaizduotas linija. 

Norėdami panaikinti ryšį, dialogo lange Relationships spragtelėkite ant linijos, kuri vaizduoja ryšį (linija 

taps ryškesnė) ir nuspauskite klavišą Del. Access paklaus, ar tikrai norite panaikinti ryšį, spustelėkite 

mygtuką OK.  

Duomenų įvedimas į lentelę 

Duomenis galėsite įvesti į lentelę, kai ekrane išsikviesite duomenų įrašų formavimo ir tvarkymo langą  

Jeigu dabar ekrane matote lentelės struktūros konstravimo langą pasirinkite komandą 

View⇒Datasheet  View. Arba mygtukų juostoje nuspauskite mygtuką  

Pastaba: Jeigu norite įvesti duomenis į seniau sukurtą lentelę, duomenų bazės organizavimo lange 

pažymėkite lentelės, į kurią norite įvesti duomenis (kol kas galbūt turite tik vieną lentelę) ir spragtelėkite 

ant mygtuko Open (atidaryti) arba su pele dukart spragtelėkite lentelės vardą. 
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Pradžioje, kai duomenys dar neįvesti, ekrano viršuje, žemiau mygtukų juostos, yra lentelės struktūros 

laukų vardų eilutė. Laukų vardai žymi stulpelių vardus. 

Duomenis į lentelę reikia įvedinėti eilutėmis. Iš langelio į langelį galima pereiti spaudžiant klavišą Enter 

arba Tab. Viena užpildyta konkrečiais duomenimis eilutė – tai vienas duomenų įrašas. Jeigu įvedinėsite 

ilgesnę informaciją į Text ar Memo tipo lauką taip, kaip ir į kitus laukus, pastebėsite, kad renkama 

simbolių eilutė slenka į kairę, slepiasi ir matoma tik nedidelė jos dalis. Visą tekstą galėsite klavišais 

surinkti ekrane, peržiūrėti ar redaguoti, jeigu perkėlę žymeklį į Text ar Memo tipo lauką, nuspausite 

klavišus Shift ir F2 (abu kartu). Ekrane pasirodys Zoom langas, kuriame ir galėsite surinkti norimą arba 

redaguoti jau esamą tekstą. Baigę spustelėkite pele OK komandos mygtuką. Kai žymeklį perkelsite į kitą 

duomenų lentelės eilutę, Access sistema automatiškai išsaugos visų laukų turinį.  

Kai duomenų lentelė jau buvo pradėta pildyti anksčiau ir vėl norite tęsti duomenų įrašų pildymą, galima 

apsirinkti vieną iš veiksmų: 

1. komandų grupėje Records (įrašai) nurodykite komandą Data Entry (duomenų įvedimas) arba 

2. bakstelėkite pele tuščioje duomenų eilutėje arba 

3. paspauskite klavišus Ctrl  ir + (abu kartu) arba 

4. nuspauskite mygtuką      . 

Duomenų įrašų lentelėje nuo vieno įrašo prie kito galima pereiti žymeklio 

valdymo klavišais ↑ir↓, taip pat pele spragtelėjus ant pageidaujamo įrašo. Be 

to  galima naudoti ir lango apačioje esančius mygtukus: 

Skaičiaus langelyje galima įrašyti įrašo numerį.  

Dažnai duomenys, esantys viename lauke kartojasi kelėtoje iš eilės einančių įrašų. Jeigu norite 

nukopijuoti duomenis, esančius ankstesnio įrašo laukelyje, paspauskite klavišus Ctrl ir ‘ (apostrofas) 

kartu. 

Nereikalingą įrašą galima ištrinti. Tai padarysite spragtelėję ant įrašo ir po to pasirinkę komandą  

Edit⇒Delete Record. Arba nuspauskite klavišus Ctrl ir – (minusas) kartu. 

Lentelės struktūros redagavimas 

Laukų papildymas arba šalinimas. 

Lentelės struktūra redaguojama lentelės struktūros konstravimo lange. 

Jeigu reikia, kad lentelėje būtų dar vienas laukas, turite įterpti eilutę. Pažymėkite eilutę (kairiajame 

stulpelyje pele spragtelėkite eilutės pilkąjį mygtuką), ant kurios norite įterpti papildomą eilutę. Pasirinkite 

komandą Edit⇒Insert Row (įterpti eilutę) arba spustelėkite Insert klavišą. Virš pažymėtos eilutės 

pasirodys tuščia eilutė.  

Jei norite iš lentelės pašalinti vieną ar daugiau laukų, pažymėkite atitinkamą eilutę ir pasirinkite komandą 

Edit⇒Delete Row. Eilutė bus panaikinta kartu su joje esančiais duomenimis. Jeigu naikinote eilutę, 
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bet apsirikote, galite vėl ją grąžinti į lentelę, jei tuoj pat pasirinksite komandą Edit⇒Undo Delete. 

Laukų perkėlimas į kitą vietą. 

Pažymėkite eilutę, kurioje įrašytas vardas to lauko, kurį norite perkelti į kitą vietą (bakstelėkite pele 

eilutės mygtuką). Pelės rodyklės smaigaliu nusitaikykite į pažymėtos eilutės baltą trikampę rodyklę ant 

eilutės mygtuko. Pelės rodyklės apačioje atsiras kvadratėlis. Laikydami nuspaustą kairįjį pelės klavišą 

tempkite eilutę aukštyn arba žemyn į tą vietą, kurioje ji turi būti, ir atleiskite pelės klavišą. 

Lentelės struktūros ir dizaino keitimas įrašų lange 

Lentelę galima redaguoti, kai ekrane – duomenų įrašų lentelės langas, o duomenų lentelė jau yra 

pildoma arba užpildyta. Kai reikia, duomenų įrašų lange galima keisti ir duomenų lentelės struktūrą, ir 

jau įvestus duomenis, t. y. įrašus. Lentelės struktūra keičiama dažniausiai tada, kai siekiama geresnio 

vaizdumo, informatyvumo, skaitymo patogumo ir pan. Duomenų lentelėje galima keisti stulpelių plotį, 

eilutės aukštį, stulpelių išsidėstymo tvarką, fiksuoti stulpelius, pakeisti lentelės dizainą. 

Stulpelio pločio pakeitimas. 

Duomenų lentelės stulpelio plotį galima keisti pele. Pelės žymeklį nukelkite į laukų vardų pilkąją juostą 

(lango viršuje) ir nustatykite ties vertikaliąja stulpelius ribojančia linija. Pelės rodyklė turi pasidaryti 

dvikryptė. Nuspauskite kairįjį klavišą ir tempkite vertikaliąją liniją į kairę arba dešinę pusę tiek, kiek 

reikia. 

Stulpelio plotį galima pakeisti ir kitaip. Pažymėkite stulpelį spragtelėdami pele ant lauko vardo (jei norite 

pažymėti keletą stulpelių, tai pažymėję vieną, nuspauskite Shift ir klavišais → arba ← išplėskite 

pažymėtą sritį. Arba nuspauskite Shift ir spragtelėkite pele kitų laukų vardus, arba pelės žymeklį vilkite 

laukų vardų juosta). Kai veikimo sritį jau pažymėjote, komandų grupėje Format pasirinkite komandą 

Column Width (stulpelio plotis). Ekrane pasirodys dialogo langas Column Width, kuriame reikia 

nurodyti stulpelio plotį. 

Eilutės aukščio pakeitimas. 

Duomenų lentelės eilutės aukštį paprasčiausiai galima keisti pele. Duomenų lentelėje visos eilutės būna 

vienodo aukščio. Todėl pakanka pakeisti tik vienos eilutės aukštį – pasikeis ir kitų eilučių aukštis. 

Nukelkite pelės žymeklį į eilučių mygtukų stulpelį (lango kairėje), sustabdykite rodyklę ties eilutės linija. 

Kai pelės rodyklė pasidaro dvikryptė, nuspauskite kairįjį klavišą ir tempkite eilutės liniją žemyn 

(padidinsite) arba aukštyn (sumažinsite), kiek reikia. Taip pakeisite eilutės aukštį. 

Eilutės aukštį galima keisti ir panaudojant komandų grupės Format komandą Row Height (eilutės 

aukštis). 

Stulpelių perkėlimas. 

Jei netenkina stulpelių išsidėstymo tvarka, stulpelį galima perkelti į kitą vietą. Tai daroma taip: 

1. Pažymėkite stulpelį, kurį kelsite; 

Parengė dėst. Danguolė Ignatavičiūtė 2003m. Access - 22 



VILNIAUS KOLEGIJA EKONOMIKOS FAKULTETAS 
Informacinės technologijos 

 
2. Perkelkite pelės rodyklę ant lauko vardo, nuspauskite kairįjį pelės klavišą. Pelės rodyklės apačioje 

atsiras kvadratėlis. Laikydami nuspaustą kairįjį pelės klavišą tempkite žymeklį į naują stulpelio vietą. Kai 

prieš rodyklę pastebėsite vertikalią liniją, paleiskite kairįjį pelės klavišą. Stulpelis bus naujoje vietoje. 

Stulpelio paslėpimas. 

Kartais norime, kad laikinai nesimatytų tam tikro stulpelio. Tokiu atveju jį reikia tiesiog paslėpti. 

Duomenys bus lentelėje, tačiau ekrane jų nesimatys. Tai reikėtų daryti taip: 

1. Pažymėkite stulpelį, kurį norite paslėpti; 

2. Komandų grupėje format pasirinkite komandą hide columns (paslėpti stulpelius). 

Kai norėsite stulpelį vėl matyti, pasirinkite format⇒unhide columns. Ekrane pamatysite dialogo 

langą, kuriame bus išvardinti visi jūsų lentelėje esantys laukeliai. Laukeliai, greta kurių esančiuose 

žymimuosiuose langeliuose yra varnelės, ekrane matosi. Spragtelėkite ant žymimųjų langelių, esančių 

greta laukelių, kuriuos vėl norite matyti ekrane, o po to spragtelėkite ant mygtuko Close. 

Stulpelių fiksavimas. 

Kai duomenų lentelėje yra daug stulpelių ir visi netelpa ekrane, tačiau reikia, kad dalis jų liktų visą laiką 

matomi, yra galimybė juos paversti nejudamais kitų stulpelių atžvilgiu. 

1. Pažymėkite stulpelį ar stulpelius, kuriuos norite fiksuoti; 

2. Komandų grupėje format pasirinkite komandą freeze columns (fiksuoti stulpelius). 

Stulpelių fiksavimo ekrane galėsite atsisakyti, jei iš Format nurodysite komandą Unfreeze All 

Columns. 

Šrifto pakeitimas. 

Galima pakeisti lentelės simbolių šriftą, stilių, spalvą. Visi šie parametrai galioja visai lentelei, o ne vienai 

eilutei ar stulpeliui. 

Norėdami pakeisti lentelės simbolių šriftą, stilių ar spalvą pasirinkite Format⇒Font. Ekrane pasirodys 

šrifto dialogo langas Font. Čia pasirinksite šriftą, jo dydį, stilių, spalvą. 

Lentelės spalvos ir formos pakeitimas. 

Lentelę galima padaryti patrauklesnę pakeičiant jos 

spalvą, suteikiant jai erdvinę formą. Norėdami tai 

padaryti, pasirinkite Format⇒Datasheet. Ekrane 

pasirodys Datasheet Formatting dialogo langas. 

Šiame lange galėsite pakeisti lentelės spalvą, ištrinti 

tinklelio linijas. Norėdami suteikti lentelei trimatę 

išvaizdą, spragtelėkite ant Raised arba Sunken 

mygtukų-jungiklių Cell Effect srityje. Baigę 

spragtelėkite ant OK. 
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Duomenų rūšiavimas ir filtravimas 

Dažnai duomenis reikia surūšiuoti. Pavyzdžiui, informaciją apie mokinius pateikti abėcėlės tvarka. 

Duomenų rūšiavimui skirta Sort komanda, esanti komandų grupėje Record. Vietoj jos galima naudoti 

ir du įrankių juostoje esančius mygtukus – Sort Ascending ir Sort Descending: 

- Sort Ascending surūšiuoja tekstinius įrašus abėcėlės tvarka taip, kad A raide prasidedantys 

įrašai būna viršuje, o Z raide prasidedantys įrašai – apačioje. Skaičius ši komanda išdėsto nuo 

mažiausio iki didžiausio, datas - nuo seniausios iki naujausios. 

- Sort Descending surūšiuoja tekstinius įrašus atvirkščia abėcėlės tvarka taip, kad Z raide 

prasidedantys įrašai būna viršuje, o A raide prasidedantys įrašai – apačioje. Skaičius ši komanda 

išdėsto nuo didžiausio iki mažiausio, datas - nuo naujausios iki seniausios. 

Kartais reikia pamatyti įrašų grupę, viename laukelyje turinčią tam tikrą reikšmę. Pavyzdžiui, reikia 

išrinkti visus mokinius, turinčius vardą Tomas. Tai - duomenų filtravimas. Filtras veikia greitai, tačiau jo 

negalima išsaugoti pakartotiniam panaudojimui. Kas kartą filtrą reikia suformuoti iš naujo. 

Duomenų filtravimui skirta Filter komanda, esanti komandų grupėje Record. Galima naudoti ir įrankių 

juostoje esančius mygtukus Filter by Selection ir Filter by Form: 

Filter by Selection (filtravimas pagal pasirinkimą).  

Spragtelėkite ant laukelio su informacija, pagal kurią norite atlikti paiešką ir pasirinksite komandą 

Records⇒Filter⇒Filter by Selection arba nuspauskite mygtuką       . Ekrane bus matomi 

įrašai turintys tokį laukelį. 

Filter by Form (filtravimas pagal formą). 

Norėdami išfiltruoti įrašus pagal formą, pasirinkite Records⇒Filter⇒Filter by Form arba 

spragtelėkite ant įrankių juostoje esančio mygtuko.     . Ekraną užpildys tuščia jūsų lentelės kopija. 

Spragtelėkite ant to stulpelio, pagal kurį norite filtruoti. Laukelyje atsiras rodyklė . Spragtelėję ant 

jos atidarysite langelį su sąrašu, kuriame pamatysite visus tame laukelyje esančius įrašus. Dešiniajame 

apatiniame lentelės kampe yra kortelė, pavadinta Look For. Kai ta kortelė paryškinta, galite spragtelėti 

ant kokio nors įrašo ir paskirti jį pagrindiniu paieškos kriterijumi. Pavyzdžiui, jei norite išrinkti 

mokinius, turinčius vardą Tomas, spragtelėkite ant stulpelio Vardas, po to sąraše raskite vardą Tomas. 

Spragtelėkite ant jo. Norėdami pamatyti rezultatą pasirinkite komandą Filter⇒Apply Filter/Sort arba 

spragtelėkite ant mygtuko Apply filter .  

Jeigu norite išrinkti ne vien mokinius, turinčius vardą Tomas, bet ir mokines, vardu Toma, pasinaudokite 

kortele Or (esančia greta Look For) – spragtelėkite ant jos, po to ant stulpelio Vardas, atidarykite 

sąrašo langelį ir jame suradę vardą  Toma spragtelėkite ant jo. 
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Užklausos 

Užklausa (query) – tai klausimas apie lentelėje esančius duomenis. Užklausos sudaro sąrašus iš vienos ar 

daugiau lentelių, skaičiuoja įrašus, atlieka skaičiavimus pagal tai, ką randa duomenų bazėje. 

Užklausos dažniausiai kuriamos, kai reikia atlikti tam tikrų duomenų apiešką (atranką), nors gali būti 

sudaromos ir duomenų modifikavimui. Vykdant užklausas, duomenys gali būti imami iš atskirų lentelių, 

susietų lentelių ar kitų užklausų. Yra tokie pagrindiniai užklausų tipai: 

1. Paprastos, t.y. Surenkančios duomenis iš vienos ar kelių lentelių; 

2. Atrenkančios, t.y. Imančios duomenis iš vienos ar kelių lentelių pagal suformuotą atrankos kriterijų; 

3. Skaičiuojamosios, kuriose formuojami laukai su apskaičiuotomis reikšmėmis; 

4. Suvestinės, kuriose galimas duomenų grupavimas ir duomenų grupių charakteristikų skaičiavimas; 

5. Parametrinės, kuriose gali būti keičiamos paieškos kriterijaus parametrų reikšmės (jas įvedant); 

6. Kryžminės – jose duomenys turi formatą, panašų į tą, kuris naudojamas elektroninėse lentelėse 

(skaičiuoklėse). 

Konkrečioje užklausoje gali būti apjungti įvairūs tipai. 

Sudėtingas filtravimas 

Sudėtingą filtrą, panašų į paprasčiausią užklausą galima sudaryti naudojant komandą Record⇒ Filter⇒ 

Advanced Filter/Sort. Atsidarykite duomenų bazėje Mano klasė esančią lentelę Draugai. Sukursime 

filtrą, kuris išrinks kovo mėnesį gimusius draugus. 

Pasirinkite komandą Record⇒Filter⇒Advanced Filter/Sort. Ši komanda iškvies pažangaus 

filtravimo ir rūšiavimo dizaino langą. 

Viršutinėje lango dalyje yra mažas langelis. Tai laukelių sąrašas (Field List). Kuriame matosi visi aktyvioje 

lentelėje esantys laukeliai. Apatinėje ekrano dalyje yra tuščias užklausos tinklelis, kuriame rašoma 

filtravimo informacija. Tarkime, jog mums reikia pavardžių, vardų ir gimimo datų. 

Laukelių 

sąrašą galima 

apdoroti 

dviem būdais: 

dukart 

spragtelėkite 

ant laukelio 

pavadinimo 

laukelių sąraše 

ir apatinėje 
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Advanced Filter/Sort lango dalyje esančiame užklausos tinklelyje atsiras tą laukelį atitinkantis įrašas 

arba nustatykite pelės žymeklį ties reikiamo laukelio pavadinimu, ir nuspauskite kairįjį pelės klavišą, 

laikydami pelės klavišą nuspaustą, nuveskite žymeklį iki užklausos tinklelio.  

Žymeklis pavirs stačiakampiu. Kai tas stačiakampis bus reikiamoje vietoje, pelės klavišą atleiskite. 

Įtraukite į užklausos tinklelį laukus pavardė, vardas, gimimo data. 

Kai laukelis pereis į užklausos tinklelį, lentelėje greta jo pavadinimo atsiras žemyn nukreipta rodyklė. 

Ant jos spragtelėję, pamatysite visų laukelių sąrašą. Jei reikia, šiame sąraše galite pasirinkti kitą laukelį. 

Jei į filtravimą norite įtraukti visus laukelius, dukart spragtelėkite ant laukelių sąrašo antraštės ir 

pažymėkite visus laukelius. Po to nuvilkite visą sąrašą žemyn į užklausos tinklelį.  

Jei norite kurį nors laukelį ištrinti, pažymėkite jį spragtelėdami ant jo pavadinimo esančio pilko 

stačiakampio (kai pelės žymeklį nustatysite ties šiuo stačiakampiu, jis įgaus juodos žemyn nukreiptos 

rodyklės formą) ir nuspauskite Delete klavišą arba pasirinkite komandą Edit⇒Delete Columns. 

Jei norite ištrinti visus laukelius iš karto, pasirinkite komandą Edit⇒Clear Grid. 

Rūšiavimas. 

Įterpę visus užklausai būtinus laukelius, nustatykite, pagal kurį laukelį norite rūšiuoti duomenis. 

Užklausos tinklelyje spragtelėkite ant to stulpelio Sort eilutės. Pamatysite žemyn nukreiptą rodyklę. 

Spragtelėję ant jos, pamatysite sąrašą, kuriame galėsite pasirinkti rūšiavimą didėjančia (ascending) arba 

mažėjančia (descending) tvarka. Programai galima nurodyti, kad ji rūšiuotų duomenis pagal keletą laukelių, 

tačiau rūšiavimo procesas visada prasideda nuo užklausos tinklelio kairėje pusėje esančio laukelio. Kai 

Access tame laukelyje randa įrašus su vienoda informacija, pradeda rūšiuoti pagal kitus nurodytus 

laukelius, tinklelyje eidamas iš kairės į dešinę. (Jei norite perkelti laukelį į kitą vietą, pažymėkite jį, pelės 

žymeklį pastatykite ties stulpelio antrašte ir vilkite pelę. Kai žymeklis atsidurs ten, kur turėtų būti 

stulpelis, atleiskite pelės klavišą). 

Parinkite, kad duomenys būtų rūšiuojami pagal pavardę abėcėlės tvarka. 

Kriterijai. 

Trečioji užklausos tinklelio eilutė vadinasi Criteria (kriterijai). Šioje eilutėje nurodote, ką norite rasti. Čia 

reikia įrašyti ieškomą tekstą. Pavyzdžiui, jeigu norite išrinkti draugus, turinčius Vardą Nerijus, turite 

stulpelio vardas eilutėje Criteria įrašyti “Nerijus”, kabutes galima ir praleisti – Access pats jas pridės. 

Dažniausiai reikia nurodyti ne visą tekstą, o jo dalį. Jeigu mes norime išrinkti kovo mėnesį gimusius 

draugus, turime rašyti: *.03.*, žvaigždutė reiškia, jog vietoj jos gali būti bet kokie simboliai. Pastebėsite, 

jog Access užrašą šiek tiek papildys pridėdamas žodelį Like ir teksto fragmentą paimdamas į kabutes. 

Jeigu norite išrinkti ne vien kovo, bet ir balandžio mėnesį gimusius draugus, gimimo data stulpelio eilutėje 

Or parašykite: *.04.* Norėdami pamatyti išfiltruotus duomenis, pasirinkite Filter⇒Apply 

Filter/Sort arba spragtelėkite ant įrankių juostoje esančio filtro pritaikymo mygtuko Apply 
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Filter 

Norėdami vėl matyti visus duomenis, dar kartą spragtelėkite ant Apply Filter mygtuko ir taip išjungsite 

filtrą. 

Nurodant kriterijų, galima naudoti ir palyginimo operacijas (>, <, >=, <=, <>, =). Pavyzdžiui, jei 

norite išrinkti draugus, gimusius vėliau negu 1982.04.01, stulpelio gimimo data eilutėje Criteria įrašykite: 

>1982.04.01 

Pabandykite sukurti filtrą, kuris išrinktų draugus, gyvenančius vienoje gatvėje. 

Jei susikursite naudingą filtrą, kuriuo norėsite pasinaudoti ir ateityje, išsaugokite jį kaip užklausą. Tai 

padarysite spragtelėję ant mygtuko Save as Query  

Ekrane pasirodys dialogo langas Save as Query. Įrašykite užklausos pavadinimą ir paspauskite OK. 

 

Užklausų parengimas  

Atsidarykite duomenų bazę Biblioteka. Duomenų 

bazės organizavimo lange spragtelėkite ant Query 

kortelės. Atsidariusiame lange spragtelėkite ant 

New. Pasirodys naujos užklausos New Query 

langas. 

Šiame lange galima pasirinkti, ar norėsite 

savarankiškai kurti užklausą, ar naudosite 

konstruktorių. 

Pasirinkite savarankišką užklausos kūrimą – Design View ir spragtelėkite ant OK. Pasirodys Show 

Table dialogo langas. 

Show Table dialogo lange galima pasirinkti 

vieną ar keletą lentelių bei anksčiau sukurtų 

užklausų, iš kurių bus formuojama nauja 

užklausa. 

Pirmam bandymui pasirinkite vieną lentelę 

Kūriniai – spragtelėkite ant lentelės pavadinimo, 

po to ant mygtuko Add. Pasirinkę lentelę 

spragtelėkite ant mygtuko Close. Show Table dialogo langelis išnyko. Ekrane bus matoma užklausa 

Design View dizaino vaizde. 
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Užklausos tinklelis panašus į pažangaus filtravimo. Užklausos pasirinkimas veikia panašiai kaip 

pažangus filtravimas ir rūšiavimas. Laukelius iš lentelės perkeliame į užklausos tinklelį, nustatome 

išsidėstymo tvarką ir 

kriterijus kaip 

pažangiame filtravime 

ir rūšiavime. 

Užklausos 

pasirinkimo langelyje 

yra eilutės Table ir 

Show, kurių neturi 

pažangus filtravimas. 

Eilutėje Table 

nurodome iš kurios lentelės imamas laukas (kol kas imame iš vienos). Show eilutėje galima nurodyti, ar 

reikės rodyti stulpelį duomenų lape. 

Norėdami, kad užklausa parodytų rezultatus, spragtelėkite ant mygtuko Run arba pasirinkite 

komandą Query⇒Run. Norėdami grįžti į Design View dizaino vaizdą pasirinkite 

komandą View⇒Design View, arba spragtelėkite ant mygtuko View  

Norėdami išsaugoti užklausą, pasirinkite komandą File⇒Save. Atsidariusiame Save as lange įrašykite 

užklausos pavadinimą ir paspauskite OK. 

Sudarykite užklausą, kuri išrinktų knygas, išleistas ne anksčiau kaip 1995 m. ir ne vėliau kaip 1998 m. 

Į užklausą galima įtraukti laukus iš keleto duomenų bazėje esančių lentelių (lenteles prieš tai reikėtų 

susieti). Keleto lentelių užklausa kuriama labai panašiai kaip ir vienos. Skirtumas tas, jog langelyje Show 

Table pasirenkame ne vieną, o keletą lentelių, po to į užklausos tinklelį perkeliame reikalingus laukus iš 

bet kurios lentelės. Rūšiavimą, kriterijus parenkame kaip vienos lentelės užklausai. 

Pabandykite sukurti dviejų lentelių – Autoriai ir Kūriniai - užklausą, kuri išrinktų knygas, išleistas 1998 

m., nepigesnes, kaip 8 Lt ir nebrangesnes kaip 15 Lt, išrūšiuojant jas nuo pigiausios iki brangiausios.  

Užklausa turėtų būti pateikti tokią informaciją: autoriaus pavardė, vardas, kūrinio pavadinimas ir kaina 

(leidimo metų rodyti nereikia ir netikslinga – juk visos išrinktos knygos buvo išleistos 1998 m.). 

Dialoginės užklausos 

Turim duomenų bazę Mano klasė. Tarkim, norim sukurti užklausą, kuri išrinktų šį mėnesį gimusius 

draugus. Mėnesių yra dvylika ir kiekvienam mėnesiui reikėtų kurti naują užklausą arba redaguoti jau 

turimą. Tokiu atveju patogu sukurti dialoginę užklausą, kuri paprašytų įrašyti mėnesį ir pagal įrašytą 

mėnesio numerį išrinktų būtent duotą mėnesį gimusius draugus. 

Atsidarykite duomenų bazę Mano klasė.  Pasirinkite Queries ir spragtelėkite ant New. Pasirinkite 
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Design View. Dialogo lange Show Table pasirinkite lentelę Draugai. Pasirinkite laukus Pavardė, Vardas, 

Gimimo data. Norėdami išrinkti, tarkim, kovo mėnesį gimusius draugus, stulpelio Gimimo data eilutėje 

Criteria rašytume Month([Gimimo data])=3. Norėdami įrašyti bet kokį mėnesį turime rašyti: 

Month([Gimimo data])=[Įrašykite mėnesio numerį]. T. y. laužtiniuose skliaustuose įrašome tekstą, 

pranešantį, ką reikia įrašyti. Nuspaudus Run mygtuką, ekrane pasirodys dialogo langas Enter 

Parameter Value. 

Čia galėsite įrašyti mėnesio numerį ir Access išrinks duotą 

mėnesį gimusius draugus (nepamirškite juos pasveikinti). 

Taigi, dailoginė užklausa sudaroma į stulpelių, kurie bus 

naudojami kaip parametrai, eilutę Criteria laužtiniuose 

skliaustuose įrašant paaiškinamąjį tekstą. 

Jei norime sukurti tokią dialoginę užklausą, kuriai pakaktų įvesti ne visą lauko reikšmę, o tik dalį, turime 

sujungti parametrą su simboliu “*”. Pavyzdžiui Like [Įrašykite pavardę:] & “*”. Vykdant užklausą su 

tokiu kriterijumi pakaks įrašyti pavardės pradžią. 

Sukurkite dialoginę užklausą, kuri padėtų surasti informaciją apie draugą įrašius jo vardą (užklausą 

kurkite lentelei Draugai ). 

Sudarykite dialoginę užklausą, kuri rastų visus nurodytoje gatvėje gyvenančius draugus, apie kuriuos 

informaciją turite lentelėje Draugai. 

Skaičiuojami laukai 

Užklausoje gali būti skaičiuojami laukai – tai laukai, kuriuose yra duomenys, gaunami atlikus 

skaičiavimus su kituose laukuose esančiais duomenimis. Norėdami sukurti skaičiuojamą lauką, turime 

eilutėje Field įrašyti reiškinį. Prieš reiškinį patartina parašyti lauko vardą ir dvitaškį. Pavyzdžiui, suma: 

[kaina]*[kiekis]. 

Skaičiuojamų laukų aprašymo sandara: 

<Lauko vardas>:<reiškinys> 

Reiškiniuose (expressions) nurodoma, kokius veiksmus, su kokiais argumentais ir kokia tvarka reikia 

atlikti. Skaičiavimų veiksmai aprašomi tradiciniais aritmetiniais operatoriais (^, *, /, +, -), kurių 

argumentais gali būti konstantos, laukų reikšmės funkcijos ir kiti reiškiniai. Jei argumentas yra kito lauko 

reikšmė, tai nurodoma užrašant lauko pavadinimą laužtiniuose skliaustuose. Reiškinių operatorių 

vykdymo tvarką nusako jų prioritetai, o vienodo prioriteto operatoriai vykdomi jų įrašymo reiškinyje 

tvarka. Prioritetais nusakomą natūralią operatorių 

vykdymo tvarką galima pakeisti lenktiniais skliaustais. Kitų 

tipų skliaustus šiam tikslui vartoti draudžiama.  

Simboliai Pavadinimas Prioritetai 
^ Kėlimas laipsniu 1 

*, / Daugyba ir dalyba 2 
+, - Sudėtis ir atimtis 3 

Kreipinio į funkcijas sandara yra tokia: 
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<Funkcijos vardas>(<reiškinys>) 

Teisingai užrašyti reiškinius padeda reiškinių kūrėjas (Expression Builder), kuris iškviečiamas 

paspaudus mygtuką Build  

Pavyzdžiui, datos funkcijos: 

♦ Day(<Datos kodas>) – funkcijos reikšmė grąžina argumento nurodomos datos mėnesio dieną; 

♦ Month(<Datos kodas>) - funkcijos reikšmė grąžina argumento nurodomos datos mėnesio 

numerį; 

♦ Year(<Datos kodas>) - funkcijos reikšmė grąžina argumento nurodomos datos metus. 

Jei skaičiuojamo lauko eilutėje Field praleidžiamas lauko vardas, jam yra suteikiamas standartinis vardas 

Expr1, Expr2 ir t.t., kurį po to galima redaguoti. 

Neturinti argumentų funkcija Now() grąžina kompiuterio laikrodžio rodomą datos ir laiko kodą. Vien 

tik datos kodą grąžina funkcija Date(). Užklausos panaudojimo mėnesį ir dieną skaičiuoja reiškiniai 

Month(Now)) ir Day(Now()). 

Eilutėje Show (rodyti) pelės spragtelėjimu keičiamomis žymėmis nurodoma, kurių laukų reikšmes rodyti 

užklausos rezultatų lentelėje. 

Suvestinių duomenų užklausos 

Suvestinėmis vadinami dokumentai su apibendrinančiais duomenimis. Tokiuose dokumentuose 

dažniausiai yra pateikiamos įvairiems duomenų požymiams tenkančios sumos, statistiniai analizuojamų 

duomenų įverčiai. Duomenų bazėse laikomi duomenys dažnai naudojami suvestinėms sudaryti, todėl 

jose yra ištisas rinkinys suvestinių duomenų skaičiavimo funkcijų, kurios programoje MS Access 

vadinamos agregatinėmis (Aggregate). Taip pažymima, kad jų argumentai yra duomenų rinkiniai. 

Dažniausiai šios funkcijos vartojamos ataskaitų sudarymui, tačiau dalį jų sėkmingai galima vartoti 

užklausose. 

Suvestinių duomenų užklausų laukus galima suskirstyti į dvi skirtingos paskirties grupes: grupavimo 

požymių ir skaičiavimo argumentų laukus. Suvestinių duomenų skaičiavimo laukuose grupavimo 

požymių nuorodas pakeiskite suvestinių funkcijomis, kurios parenkamos iš eilutėje Totals atveriamų 

sąrašų.  

Galima parengti užklausą įrašams su panašiomis laukų reikšmėmis grupuoti bei sugrupuotiems 

duomenims apskaičiuoti. 

Atsidarykite duomenų bazę Biblioteka. Suformuosime užklausą, kuri suskaičiuos, kiek kurio autoriaus 

knygų yra bibliotekoje ir kokia bendra jų vertė. 

Duomenų bazės organizavimo lange pasirinkę kortelę Query spragtelėkite ant mygtuko New. Pasirinkite 

savarankišką užklausos rengimo būdą Design View. Show Table langelyje pasirinkite lentelę Kūriniai. Į 

užklausos tinklelį perkelkite laukus Autoriaus pavardė, Pavadinimas, Kaina. Spragtelėkite ant 
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mygtuko Totals  arba pasirinkite komandą View⇒Totals.  

 
Užklausos langas pasipildys eilute Totals. 

Kiekvieno stulpelio Total eilutėje atsiras Group By įrašas, kuris reiškia, jog nustatomas įrašų grupavimo 

režimas. Kiekviename lauke bus automatiškai rūšiuojami įrašai su vienodomis reikšmėmis. Stulpelyje 

Kaina vietoj Group By pasirinkite Sum. Sukurkite vieną apskaičiuojamą lauką – Kiekis – tuščio stulpelio 

eilutėje Field užrašykime Kiekis: Pavadinimas, o eilutėje Group By pasirinkite Count. 

Kryžminių suvestinių užklausos 

Analizuojant duomenis, plačiai vartojami kryžminėmis suvestinėmis vadinami dokumentai, kuriuose 

aprašomas duomenų pasiskirstymas pagal du požymius. Tokių suvestinių eilutės skiriamos vieno 

požymio reikšmėms, o stulpeliai – kito požymio reikšmėms. Stulpelių ir eilučių sankirtose įrašomi 

užklausos suskaičiuoti paskirstomų duomenų įverčiai. Tai gali būti abu požymius tenkinančių duomenų 

lentelės įrašų skaičiai, laukų reikšmių sumos arba įvairūs statistiniai įverčiai. Kryžminių suvestinių 

sudarymui naudojamos specialios Crosstab Query tipo užklausos, kurias patogu parengti naudojantis 

užklausų vedliu (Query Wizard). 

Pagrindiniame duomenų bazės lange atverkite 

užklausų langą Queries ir įrankių juostoje 

paspauskite naujos užklausos kūrimo mygtuką 

 arba parinkite pagrindinio meniu komandą 

Insert/Query. Jums bus atvertas naujos užklausos 

kūrimo priemonių pasirinkimo langas, kuriame 

dukart spragtelėję su pele pasirinkite tipą Crosstab 

Query Wizard. 

Dabar bus atvertas užklausos kūrimui perduodamų lentelių parinkimo langas, kuriame taip pat matysite 

kryžminės suvestinės sandaros vaizdą. Parinkite duomenų šaltinių sąrašo lauke lentelę Sultys ir mygtuku 
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Next> pereikite į kitą užklausų vedlio langą. 

  
kitame lange iš sąrašo Available Fields (esami laukai) į sąrašą Selected Fields (pasirinkti laukai) 

mygtuku  perkelkite eilutėms skirto požymio laukų Metai ir Sezonas pavadinimus.apatinėje lango 

dalyje matysite lauko reikšmių naudojimą suvestinėje iliustruojančią schemą. Sudarant kryžmines 

suvestines sudėtingesnės sandaros lentelėms, suvestinės eilutėse duomenis galima paskirstyti ir pagal 

kelių požymių reikšmes.  

 
Mygtuku 

 iš 

eilučių požymių 

parinkimo lango 

pereinama į 

stulpelių požymių 

lauko parinkimo 

langą. Jis yra 

analogiškas eilučių 
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požymių parinkimo langui, tačiau čia galima pasirinkti tiktai vieną stulpelių pavadinimams skirtą lauką.  

 
Vėl paspaudus mygtuką Next>, atveriamas dar vienas vedlio langas, kuriame reikia nurodyti lauko su 

paskirstomais duomenimis pavadinimą (sąrašas Fields) ir duomenų paskirstymo įverčio funkciją 

(sąrašas Functions). Sąraše Functions rodomų funkcijų rinkinys priklauso nuo paskirstomų duomenų 

lauko tipo. 

Pažymėtas Yes, include row sums (įterpkite eilučių sumas) žymimasis langelis rodo, kad kiekvienai 

kryžminės suvestinės eilutei bus skaičiuojamos visų jos duomenų sumos. 

Nurodę duomenų paskirstymui pasirinktą lauką, vėl spauskite mygtuką Next>. Jis jums atvers paskutinį 

vedlio langą, kuriame tereikia nurodyti sukurtos užklausos vardą ir paspausti mygtuką Finish. Ekrane 

pamatysite užklausos rezultatų lentelę su kryžminės suvestinės duomenimis. 

 

Mygtuku  atvėrus užklausos lentelę, galima pamatyti kryžminių suvestinių užklausų projektavimo 

priemones ir pakeisti vedlio sukurtos užklausos bei atskirų jos laukų savybes. Pavyzdžiui, suvestinėje yra 

nepageidaujamas standartinis eilučių duomenų sumų pavadinimas Total of Parduota. Padėję žymeklį 

bet kurioje šių sumų stulpelio eilutėje ir iš konteksto meniu pasirinkę komandą Properties, jos atverstos 

kortelės eilutėje Caption (antraštė) galėsite šiam stulpeliui paskirti tinkamą pavadinimą. 
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Kairėje vaizduojamas lauko 

pavadinimo keitimo langas. 

Eilučių sumų stulpelio 

eilutės Total 

išskleidžiamame sąraše 

galima pakeisti eilučių duomenų įverčio funkciją (vaizduojama dešinėje). 

Lentelės kūrimo užklausa 

Iki šiol nagrinėtos užklausos yra vadinamos atrankos užklausomis, nes jos 

atrenka duomenis iš bazės lentelių pagal vartotojo nurodytus požymius. 

Tokių užklausų rezultatų lentelės yra laikini dariniai, kurie formuojami iš 

naujo kiekvieną kartą, kai tiktai yra vykdoma užklausa. Jeigu pageidaujama, 

kad atrinkimo užklausos rezultatai būtų laikomi kartu su kitais bazės 

duomenimis, atrankos užklausą reikia pertvarkyti į lentelės kūrimo užklausą. 

Tarkime, kad norime papildyti duomenų bazę nauja lentele su kurios nors 

užklausos rezultatais. Pagrindinio lango užklausų kortelėje išrinkite 

užklausos pavadinimą ir mygtuku Design atverkite jos struktūros langą. 

Tada pagrindinio meniu komanda Query galėsite atverti jos meniu lentelę, 

kurioje galėsite pakeisti užklausos tipą.  

Parinkus lentelės elementą Make-Table 

Query (lentelės kūrimo užklausa) ekrane 

atveriamas langas naujai kuriamos lentelės 

vardui įrašyti. Įrašius šiame lange naujos 

lentelės vardą ir paspaudus mygtuką OK, 

atrankos užklausa tampa lentelės kūrimo 

užklausa, tačiau nauja lentelė nesukuriama. Nurodyto vardo užklausos rezultatų lentelė yra sukuriama 
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arba atnaujinama (jeigu ji jau buvo sukurta) kiekvieną kartą, kai paspaudžiamas priemonių juostos 

mygtukas Run arba kai ji pasirenkama pagrindinio lango kortelėje Query. 

Komanda Query/Select Query iš naujos lentelės užklausos galima vėl padaryti atrankos užklausą. 

Lentelių papildymo užklausos 

Savo sudaromą lentelę lentelių kūrimo užklausa kiekvieną kartą perrašo iš naujo. Tai ne visada 

pageidautina. Pavyzdžiui, tarkime, kad duomenų bazėje lentelė Gavimas yra kuriama kiekvieną mėnesį 

iš naujo, o lentelėje Prekių_Sumos turi būti kaupiami kiekvieną mėnesį sudaromų suvestinių 

duomenys. Tokiu atveju, komanda Query/Append Query (prijungimo užklausa) lentelių kūrimo 

užklausą reikia pertvarkyti į prijungimo užklausą, kuri atrenkamus įrašus prijungia prie buvusių 

paskirties lentelėje įrašų. Tačiau reikia žinoti, kad prijungimo užklausa nekuria naujos lentelės. Todėl dar 

reikės sukurti prijungimo užklausos rezultatams pritaikytą tuščią lentelę arba pirmą mėnesį tokią lentelę 

sukurti su lentelių kūrimo užklausa, o tik po to šią užklausą pertvarkyti į prijungimo užklausą. 

Pašalinimo užklausa 

Norint ištrinti didelę įrašų grupę patogu sukurti pašalinimo užklausą. Tam pirmiausiai reikia sukurti 

išrinkimo užklausą (visos mūsų lygi šiol nagrinėtos užklausos ir buvo išrinkimo užklausos) ir įsitikinti, 

jog ji išrenka būtent tuos įrašus, kuriuos norite ištrinti. Tada reikia grįžti į dizaino režimą (komanda 

View⇒Design View arba nuspausti mygtuką View), pasirinkti komandą Query⇒Delete Query ir vėl 

paleisti užklausą. Ekrane pasirodys pranešimas, kuriame bus klausimas, ar esate įsitikinę, jog norite 

ištrinti įrašus. 

Pakeitimų užklausa 

Galima pakeisti įrašų grupės duomenis suformavus  atnaujinimo užklausą. Tam pirmiausiai reikia 

sukurti išrinkimo užklausą ir įsitikinti, jog ji išrenka būtent tuos įrašus, kuriuos norite atnaujinti. Tada 

reikia grįžti į dizaino režimą (komanda View⇒Design View arba nuspausti mygtuką View), pasirinkti 

komandą Query⇒Update Query, po to laukelio, kurio duomenis norite keisti, eilutėje Update To 

reikia įrašyti naują laukelio reikšmę ir paleisti užklausą. 

Formos 

Formos (Forms) yra naudojamos duomenų įvedimui, vaizdavimui ir redagavimui. Formos lange vienu 

metu matomi visi vieno įrašo laukai, kuriuose galima rašyti duomenis, juos koreguoti arba pašalinti. 

Formos kuriamos lentelėms ir užklausoms. 

Paprasčiausiai forma kuriama naudojant formų konstruktorių.  

Sukurkime įvedimo formą lentelei Kūriniai. 

Pagrindiniame lange pasirinkite Forms kortelę. Paspauskite joje mygtuką New ir užklausos langelyje 

Parengė dėst. Danguolė Ignatavičiūtė 2003m. Access - 35 



VILNIAUS KOLEGIJA EKONOMIKOS FAKULTETAS 
Informacinės technologijos 

 
pasirinkite variantą Form Wizard (formų konstruktorius). Atverto konstruktoriaus pirmojo žingsnio 

dialogo lango lauke Tables/Queries  pasirinkite lentelę Kuriniai, kurios užpildymui kuriama forma.  

Į formą įtraukite visus lentelės 

laukelius. Available Fields sąraše 

du kartus spragtelėkite ant 

laukelio pavadinimo taip jį 

įtraukdami į formą (laukelių 

pavadinimus įtraukti į formą 

galima ir naudojant  mygtuką >). 

Norint perkelti į formą visus 

lauke Available Fields matomus 

pasirinktos lentelės laukus, 

pakanka paspausti mygtuką >>. Jei norite pašalinti laukelį, kurį netyčia pasirinkote, dukart spragtelėkite 

ant jo pavadinimo Select Fields sąraše (arba naudokite mygtuką <).  

Perkėlę reikiamus laukelius į 

Selected Fields lauką, spauskite 

mygtuką Next, kuris atvers antrąjį 

konstruktoriaus langą su leistinų 

formų tipų sąrašu. 

Dažniausiai renkamės tipą 

Columnar - formos laukai bus 

išdėstomi stulpeliu. Pasirinkę 

formos tipą vėl spaudžiame Next. 

Pasirodys langas, kuriame galima 

pasirinkti formos foną.  

Pasirinkę foną, spaudžiame Next ir 

atsidariusiame lange įrašę formos 

vardą nuspaudžiame mygtuką 

Finish. 

Galima pasinaudoti ir autoforma. 

Pagrindiniame lange pasirinkite 

Forms kortelę. Paspauskite joje 

mygtuką New ir užklausos langelyje 

pasirinkite vieną iš trijų variantų: 

AutoForm: Columnar, AutoForm: Tabular, AutoForm: Datasheet. Spragtelėkite ant žemyn 
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nukreiptos rodyklės šalia tekstinio langelio ir pasirinkite lentelę ar užklausą, kurios duomenis naudosite 

formoje. 

Jeigu dirbate su lentele ar užklausa, kuriai norite greit sukurti formą, tiesiog paspauskite mygtuką New 

Object… 

Sukurtą formą galima koreguoti. Tam reikia įkelti formą į konstruktoriaus režimą paspaudžiant mygtuką 

View arba pasirenkant komandą View⇒Design View.  

Jei konstruktoriaus režime pakeičiame laukelių išdėstymo tvarką, reikia pakeisti Tab Index parametrą, 

nes priešingu atveju spaudinėjant Tab klavišą laukeliai bus „apeinami“ senąja tvarka. Norint pakeisti 

Tab Index parametrą reikia pasirinkti View⇒Tab Order ir spragtelėti ant Auto Order mygtuko – 

laukeliai bus surikiuoti tokia tvarka, kokia jie išdėstyti formoje. 

Jei nepatinka formos fono piešinys, jį galima 

pakeisti. Dizaino režime pažymėkite formą 

pasirinkdami Edit⇒Select Form. Atsidarykite 

Properties langą pasirinkdami 

View⇒Properties.  

Pakeiskite savybę Picture – paspaudus ant jos 

reikšmės, atsiranda mygtukas su trim taškais. 

Paspauskite šį mygtuką. Atsidarys Insert 

Picture dialogo langas, kuris leis susirasti kitą 

piešinį. 

Ataskaitos 

Lentelėse ir užklausose duomenys 

pateikiami standartine forma. 

Norint šią informaciją pateikti 

ekrane ar atspausdinti kitokiu būdu, 

kuriamos ataskaitos (Reports).  

Paprasčiausiai ataskaita kuriama 

pasirenkant ataskaitų konstruktorių. 

Atverkite duomenų bazę Biblioteka. 

Tarkime, jog reikia ataskaitos, iš 

kurios galėtume sužinoti, kiek 

bibliotekoje yra knygų ir kiek yra 

kiekvieno autoriaus knygų. 
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Pagrindiniame lange pasirinkite Reports kortelę. Paspauskite joje mygtuką New ir užklausos langelyje 

pasirinkite variantą Report Wizard (ataskaitų konstruktorius). Atverto konstruktoriaus pirmojo 

žingsnio dialogo lango lauke Tables/Queries pasirinkite lentelę, kurios duomenis norite pavaizduoti 

ataskaitoje. Pasirinkite lentelę Kūriniai. 

Iš Available Fields sąrašo reikiamus laukelius perkelkite į Select Fields sąrašą (Laukelį iš vienos pusės 

į kitą perkelti lengviausia spragtelint ant jo du kartus. Nesvarbu, kurioje pusėje esate, dukart spragtelėję 

perkelsite laukelį į priešingos pusės sąrašą. Visus laukelius perkeliame su mygtukais >> ir <<). 

Perkelkite laukelius Autoriaus pavardė, Pavadinimas, Leidimo metai ir Kiekis. 

Spauskite mygtuką Next, kuris dažniausiai 

atveria antrąjį konstruktoriaus langą, 

kuriame galima nurodyti, kaip norime 

surūšiuoti duomenis. 

Norėdami pasirinkti rūšiavimą pagal kurį 

nors laukelį, du kartus spragtelėkite ant 

laukelio pavadinimo esančio kairėje. 

Pasirinktas laukelis atsiskiria nuo kitų, 

atsiranda dešinėje viršuje parašytas 

mėlynomis raidėmis, ir sufleruoja, kad visa 

informacija bus surūšiuota pagal tą laukelį. Jei suskirstymas į grupes nereikalingas, perkelkite visus 

mėlynai parašytus laukelius iš dešinės į kairę. 

Pasirinkime rūšiavimą pagal Autoriaus pavardę. Ir spauskime Next. 

Pasirodo dialogo langas, kuriame įrašus 

galime surūšiuoti pagal likusius laukelius, 

sudėlioję juos didėjimo ar mažėjimo tvarka.  

Surikiuokime kiekvieno autoriaus knygas 

pagal pavadinimus, o jeigu bus vienodo 

pavadinimo knygų, surikiuokime jas pagal 

leidimo metus. Tam pirmajame 

išsiskleidžiančiame meniu pasirinkime 

laukelį Pavadinimas (pagal nutylėjimą bus rikiuojama nuo A iki Ž, jei norite priešingai reikėtų paspausti 

ant dešinėje esančio mygtuko, bet mes to šį kartą nedarykime). Antrajame išsiskleidžiančiame meniu 

pasirinkime laukelį Leidimo metai (jei bus vienodą pavadinimą turinčių knygų, seniausia bus pirmoji, jei 

norite, kad vienodą pavadinimą turinčios knygos būtų sudėliotos nuo naujausios iki seniausios, 

paspauskite dešinėje esantį mygtuką). 
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Dialogo lango apatinėje dalyje yra 

mygtukas Summary Options… Jį 

naudojame, kai norime 

apibendrinti (dažniausiai – 

susumuoti) kurio nors laukelio 

duomenis. Paspauskite ant šio 

mygtuko. Pamatysite dialogo 

langą, kuriame galima pasirinkti 

sumos, vidurkio skaičiavimą, 

didžiausios, mažiausios reikšmės 

radimą. Paspauskite ant langelio 

Sum – ataskaitoje bus pateikta 

kiekvieno autoriaus bendra knygų vertė ir visų knygų bendra vertė. 

Dešinėje Summary Options dialogo langelio pusėje yra Show variantas. Norėdami iš karto pamatyti 

duomenis ir apibendrinimą, spragtelėkite ant Details and Summary mygtuko-jungiklio. Norėdami 

pamatyti tik apibendrintą informaciją, spragtelėkite virš Summary Only mygtuko-jungiklio. Jei 

spragtelėsite ant mygtuko Calculate percent of total for sums, bus skaičiuojama visų laukelių reikšmių 

suma ir pateikiama kiekvieno įrašo dalis procentais lyginant su gauta suma. 

Mes paspauskime mygtuką-jungiklį Details 

and Summary ir spauskime mygtuką OK, 

sugrįšime į Report Wizard pranešimų 

konstruktorių. Spragtelėkite ant Next. 

Ekrane pasirodys dialogo langas, kuriame 

savo pranešimą galite sutvarkyti pagal bet 

kurį Access siūlomą stilių.   

Layout langelyje spragtelėkite virš kurio 

nors laukelių išdėstymo stiliaus, kairėje 

pusėje esančiame langelyje pamatysite, kaip 

atrodys jūsų ataskaita. Orientation langelyje galima pasirinkti lapo orientaciją. Jei pažymėtas langelis 

Adjust field width so all fields fit on a page visi laukeliai bus sutalpinti į vieną puslapį. 

Pasirinkę laukelių išdėstymo stilių spauskite ant Next. Ekrane pasirodys dialogo langas, kuriame galima 

pasirinkti vieną iš šešių ataskaitos apipavidalinimo stilių. Kairėje esantis langelis leis įsivaizduoti, kaip 

atrodo tam tikras stilius. 
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Dar kartą paspauskite ant Next. Ekrane pasirodys dialogo langas, kuriame turėsite užrašyti ataskaitos 

pavadinimą. 

Įrašę pavadinimą paspauskite ant Finish ir pamatysite savo ataskaitą. 

Jei su konstruktoriumi sukurtas pranešimas nelabai jums patinka, galite jį redaguoti. Pereikite į 

konstruktoriaus režimą pasirinkę komandą View⇒Design View arba nuspaudę mygtuką View 

Konstruktoriaus režime galima keisti pranešimo elementų dydį, spalvą, vietą, ką nors ištrinti ar pridėti. 

Įrankių juostoje yra mygtukas , kurio dešinėje paspaudę 

sąrašo išskleidimo žymę, galėsite pasirinkti ar atverti tekstų 

redaktoriaus langą ar skaičiuoklės. Atvertame lange ataskaitą 

galėsite redaguoti ir įrašyti į diską kaip Word arba Excel 

dokumentą. 

Priemonių juostos mygtuku  (Toolbox – priemonių dėžutė) yra 

atveriamas ataskaitos konstravimo objektų rinkinys. Rinkinio 

elementas išrenkamas pelės spragtelėjimu . Po to pelės 

žymeklis įgauna kryželio pavidalą ir, nuspaudus kairįjį pelės klavišą, 

juo galima piešti pasirinktoje ataskaitos vietoje objekto kontūrą. Nupieštas etiketės objektas iš karto 

būna parengtas teksto įrašymui. 

 - skiriamosios ir dekoratyvinės linijos. Linijų piešimo technika yra visiškai tokia pati, kaip ir grafikos 

redaktoriuose: piešiama su pele su nuspaustu jos kairiuoju klavišu. Nupieštos linijos spalvą, storį, tipą ir 

kitas savybes galima pakeisti konteksto meniu priemonėmis. 

 - įterpti piešinį. Sukūrus piešinio objektą, ekrane pateikiamas standartinis piešinio failo parinkimo 

langas. Įterpiamas piešinys turi būti parengiamas specialiomis grafikos programomis taip, kad jis tilptų 

jam skirtame rėmelyje. Piešinius iš grafikos programos langų į ataskaitą taip pat galima perkelti per 

iškarpų atmintį komandomis Copy ir Paste. 

 - galima ataskaitoje įterpti puslapio pabaigos (Page Break) simbolį (objektą). Tokie objektai grupių 
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paraštėse įterpiami tada, kai pageidaujama kiekvieną duomenų grupę pradėti spausdinti kitame lape. 

Dauguma kitų rinkinio elementų yra naudojami sudėtingos sandaros formose ir ataskaitose. 

Kvalifikuotam ir efektyviam jų naudojimui reikia turėti išsamių žinių apie interaktyvių dialogų formų 

projektavimą ir duomenų bazių valdymo priemones. 

Papildant ataskaitą naujais duomenimis iš jos kūrimui naudojamų duomenų šaltinių laukų, vartojamas 

priemonių juostos mygtukas , kuris išskleidžia leidžiamų naudoti ataskaitoje laukų sąrašą. Parinktas 

šio sąrašo objektas pele nutempiamas į savo paskirties vietą. 

 elemento Build Event (kurti procesus) atveriamame lange galima pasirinkti skaičiavimo formulių, 

makrokomandų ir duomenų bazių valdymo programų kūrimo langus. Šios priemonės yra skirtos 

profesionaliems vartotojams. 

Išrinkimo laukai 

Duomenų bazių 

laukai dažnai 

užpildomi griežtai 

riboto rinkinio 

reikšmėmis. 

Pavyzdžiui, 

sprendžiant apskaitos uždavinius, tokie rinkiniai yra įmonės gaminamų prekių pavadinimai, duomenys 

apie užsakovus ir tiekėjus ir pan. tokiems duomenims įvesti duomenų bazėse yra speciali priemonė, 

vadinama išrinkimo (Lookup) lauku. Pavyzdžiui, išmokant 

atlyginimus darbuotojo tabelio numeris gali būti paimtas iš 

darbuotojų sąrašo lentelės. Lentelėje Mokėjimai pasirinkime 

lauko tipą (Data Type) Lookup Wizard...  

Spragtelėjus pele vedlio pavadinimą lentelės lauko tipo 

parinkimo sąraše, atveriamas pirmasis vedlio langas. Jame 

parinkimo žyme nurodoma, kaip bus sudaromas išrinkimo 

sąrašas: įkeliamas iš kitos lentelės ar užklausos (I want the lookup column to look up the values in 

atable or query) ar renkamas klaviatūra (I will type in the values that I want). Vedlys iš pradžių siūlo 

pirmąjį variantą, kuris 

dažniausiai vartojamas. Jis 

tinka ir nagrinėjamu atveju, 

todėl iškart galima spausti 

mygtuką Next>, kuris atveria 
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antrąjį vedlio langą.  

Antrojo lango srityje View parinkimo 

žymė nurodo išrinkimo sąrašo šaltinio 

tipą. Tai gali būti lentelės (Tables), 

užklausos (Queries) arba ir lentelės, ir 

užklausos. Nuo parinkto šaltinio tipo 

priklauso lango viršuje matomo 

šaltinių sąrašo turinys. Parinkus 

lentelių tipą, sąraše yra matomos visos bazės lentelės. Tai reiškia, kad išrinkimo sąrašus galima sudaryti 

ne tiktai iš susietų, bet ir iš nepriklausomų lentelių. Pasirinkę lentelę Darbuotojai, pereiname į kitą vedlio 

langą.  

Trečiajame vedlio lange nurodoma 

išrinkimo sąrašo sandara. Lango kairėje 

yra pasiekiamų šaltinio laukų sąrašas 

(Available Fileds), o dešinėje – 

išrinkimo laukui perduodamų laukų 

(Selected Fields) sąrašas. 

Nagrinėjamam uždaviniui pakanka 

mygtuku > perkelti į dešinę lauką 

Tabelio numeris. Mygtukas < grąžina 

dešiniajame sąraše išrinktą lauką į kairę, o mygtukai >> ir << yra skirti visų atitinkamo sąrašo laukų 

perkėlimui. 

pasitikrinimui skirtas vedlio 

parengtas išrinkimo sąrašas 

rodomas ketvirtajame lange. 

Paskutiniame penktajame lange 

pateikiamas vedlio siūlomas 

kuriamo išrinkimo lauko 

pavadinimas. Jį vartotojas gali 

perrašyti. Po to spaudžiamas 

pabaigos mygtukas Finish, kuris 

atveria paskirties lentelės langą sus sukurtu išrinkimo lauku. 

Sąsajinių duomenų bazių tvarkymo technologija reikalauja, kad iš pradžių būtų užpildomos pagrindinės 

lentelės ir tik po to pavaldžios. Todėl prieš rašant apie priskaitytus atlyginimus turi būti surašyti visi 

darbuotojai.  
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Jeigu vartotojas pageidauja pats klaviatūra sudaryti išrinkimo sąrašą, pirmajame vedlio lange reikia 

parinkti alternatyvą I will type in the values that I want (aš įrašysiu tas reikšmes, kurias noriu). Tada 

iš karto atveriamas ketvirtasis vedlio langas su tuščia sąrašo lentele, kurioje rašomos išrinkimui skirtos 

reikšmės. 

Duomenų importas ir eksportas 

Apdorojant duomenis kompiuteriais, aktuali įvairiomis programomis parengtų duomenų suderinamumo 

problema, nes skirtingos programos dažniausiai savo darbo rezultatus koduoja taip pat skirtingai. 

Konkrečios programos vartojamą duomenų kodavimo sistemą priimta vadinti tos programos duomenų 

formatu. Šie formatai dažniausiai vadinami juos naudojančių programų vardais. Dažnai šiam tikslui 

vartojamos santrumpos, kaip ir juos sukūrusių programų dokumentų varduose. Pavyzdžiui, galima 

sakyti, kad Access programa Access arba mdb (Microsoft Data Base) formato duomenis. Į Access 

duomenų bazę galima importuoti: iš kitų Access bazių, kitų tipų duomenų bazių (paradox, dBase, 

FoxPro), skaičiuoklių lapų, kitų MS Office failų, tekstinių failų. 

Taikyti MS Word ir MS Excel priemones programa Access parengtiems duomenims apdoroti padeda 

specialios šiam paketui skirtos sąsajos, kurių sąrašas atveriamas Tools/Office Links. 

Taip importuoti duomenis galima komanda File/Get External Data/Import. Dar galima pasirinkti 

importuojamų failų formatą. 

File/Export veiksmas atvirkščias importui. Jo paskirtis yra parengti tokius bylų formatus, kurie tiktų 

apdoroti kitomis programomis. 

Sudėtinės formos 

Duomenų suvedimui, kai yra dvi ar daugiau susijusių lentelių, 

vartojamos sudėtinės formos. Norint sukurti sudėtinę formą, 

pasirinkite formų kūrimo vedlį (Create form by using wizard). 

Atsidariusiame lange laukelyje 

Tables/Queries pasirinkite 

pagrindinę lentelę Darbuotojai. 

Lange Available fields (galimi 

laukai) rodomi visi lentelės 

laukai.spragtelėkite mygtuką, 

pažymėtą simboliu , kad visi 

lentelės laukai būtų įtraukti į naują 
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formą. Tik nespragtelėkite mygtuko Next! Tada tame pačiame lange laukelyje Tables/Queries 

pasirinkite kitą lentelę 

Mokėjimai. Perkelkite visus 

laukus, išskyrus ID. 

kitame dialogo lange vedlys siūlo 

pasirinkti formą su priklausoma 

forma (Form with subform(s)). 

Spragtelėkite mygtuką Next.  

Atsidariusiame dialogo lange 

pasirinkite punktą Tabular, nes 

tokia forma atrodo geriausiai.  

Spragtelėkite mygtuką Next. 

Kitame lange galite pasirinkti formos dizainą, 

sakysim Standard. Spragtelėkite mygtuką Next. 

Access dabar sukurs formą ir priklausomą formą. 

Programa automatiškai jiems sukurs pavadinimus. 

Paspaudę 

mygtuką 

Finish baigsite kurti sudėtinę formą. 

Gausite tokią formą: 

 
Access užtikrina, kad priklausoma forma automatiškai bus susiejama su pagrindinės formos 

duomenimis. 

Jeigu būtume pasirinkę sudėtinę susijusią formą (linked forms), langas atrodytų taip: 
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Sukūrus formą, gautume tokį formos langą: 

Pagrindinėje formoje yra mygtukas, kurį 

paspaudus atsidarys pavaldžios, susijusios 

formos langas, kuriame galėsite įvesti 

informaciją apie priskaitytus atlyginimus 

konkrečiam darbuotojui. 
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Formos elementų eilės tvarka 

 Spaudinėjant klavišą Tab formoje nuo vieno 

lauko prie kito pereinama ta tvarka, kokia jie buvo 

įterpti į formą. Jeigu norite pakeiskite tvarką, 

formos konstruktoriaus režime meniu punkte 

pasirinkite View/Tab Order. Atsidariusiame 

lange galite pakeisti kiekvieno laukelio ir valdymo 

elemento eilės tvarką. Spragtelėkite pilką langelį 

lauko pavadinimo kairėje. Pelės mygtuką paleiskite. 

Pelės žymeklį vėl nustatykite pilkame langelyje ir 

vilkite lauką į viršų, kol jis atsidurs reikiamoje 

vietoje. Tada pelės mygtuką atleiskite. 

Pradinė forma ir mygtukai 

Jeigu norite, kad kiekvieną kartą paleidžiant duomenų bazę iškart atidarytų tam tikros formos langą, 

galite nurodyti komanda Tools/Startup.  

 
Atsidariusiame lange laukelyje Display Form/Page pasirinkite formą, kurią norėtumėte matyti iškart 

atidarius duomenų bazę. 

Formų antraštėse galima įdėti 

mygtukus naujam įrašui kurti, 

ataskaitoms spausdinti ir įrašams 

ieškoti. Atsidarykite formą 

konstruktoriaus režimu. 

Pasižiūrėkite, ar yra antraštės 

juosta Form Header (formos 

natraštė). Jeigu ne, pasirinkite 
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meniu punktą View/Form Header/Form Footer. Komandų mygtukus nebūtina padėti formos antraštės 

srityje, bet ši vieta patogi tuo, kad visada matoma. Įrankių juostoje Toolbox spragtelėkite mygtuką 

Command Button . Tada – tuščią vietą viršutinėje formos konstruktoriaus srityje. Pirmasis 

mygtukas bus naujam įrašui kurti. Stulpelyje Categories pasirinkite punktą Record operations. Tada stulpelyje 

Actions pasirinkite Add new record. Spragtelėkite mygtuką Next. 

Kitame lange pasirinkite 

paveikslėlį ant mygtuko Goto 

New 2 ir pasižiūrėkite langelyje 

kairėje kaip jis atrodo. 

Spragtelėkite Next. Kitame 

lange surinkite naujo mygtuko 

pavadinimą „pridėti naują 

darbuotoją“. Spragtelėkite 

mygtuką Finish.  

Mygtukai gali būti formos atidarymui, formos uždarymui, ataskaitos peržiūrai, ataskaitos spausdinimui, 

įrašo įterpimui, trynimui, radimui ir kt. 
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Savikontrolės klausimai 

 

1. Kas yra duomenų bazė? Lentelė? Laukas? Įrašas? 

2. Kaip sukurti duomenų bazę naudojant vedlį? 

3. Kaip sukurti naują tuščią duomenų bazę? 

4. Kaip nustatomi ir keičiami lentelės laukų parametrai? 

5. Kas yra pirminis raktas? 

6. Kodėl laukai indeksuojami? 

7. Kaip nustatomi sąryšiai tarp lentelių? 

8. Kaip įvesti duomenis į lentelę? 

9. Kaip keisti lentelės struktūrą? 

10. Kaip rūšiuoti duomenis? 

11. Kaip sudaromi filtrai? 

12. Kam naudojamos užklausos ir kokios gali būti? 

13. Kaip sukurti užklausą? 

14. Kaip sudaromi kriterijai užklausose? 

15. Kaip kuriamos dialoginės užklausos? 

16. Kaip kuriami skaičiuojamieji laukai? 

17. Kaip kuriamos suvestinių duomenų užklausos? 

18. Kaip kuriamos kryžminių suvestinių užklausos? 

19. Kaip sudaroma lentelės kūrimo užklausa? 

20. Kaip sukurti papildymo užklausą? 

21. Kaip sukurti pašalinimo ir pakeitimo užklausas? 

22. Kaip sukurti formą? 

23. Kaip sukurti ataskaitą? 

24. Išrinkimo laukai? 

25. Kaip importuojami ir eksportuojami duomenys? 

26.  

27. Kaip pakeisti elementų tvarką formoje? 

28. Kaip kuriama pradinė (Startup) forma? 

29. Kaip įterpti mygtukus į formą? 

 

Parengė dėst. Danguolė Ignatavičiūtė 2003m. Access - 48 



VILNIAUS KOLEGIJA EKONOMIKOS FAKULTETAS 
Informacinės technologijos 

 

LITERATŪRA 

 
1. DĖMENIENĖ A., LIČKŪNIENĖ E. Konferencijos, seminarai, pranešimai su Microsoft PowerPoint’u. 

Kaunas, 1997. 

2. HARDY, Pia; THOMSON, Kare. Access 2000. Vilnius, 2000. 

3. Informatika I. Kaunas: Technologija, 1998. 202 p. ISBN 9986-13-639-31. (20). 

4. KAUFELDAS J. Access 97 for Windows žaliems. − Kaunas: Smaltija, 1997. 

5. Kompiuterinis raštingumas: ECDL pagrindai. Vilnius, 2001. ISBN 9986-34-070-5 

6. LEONAVIČIENĖ B. Microsoft Office 2000. Kaunas, 1999.  

7. Microsoft Office 2000 žingsnis po žingsnio. Kaunas: Smaltija, 2000. 762 p. ISBN 9986-965-17-9. (1). 

8. Microsoft Power Point 2000 žingsnis po žingsnio. Kaunas: Smaltija, 2000. 330 p.  

ISBN 9986-965-33-0. (2). 

9. STARKUS, Bangimantas. Personalinis kompiuteris. Kaunas: Smaltija, 1999. 290 p.  

ISBN 9986-965-09-8. (1) 

10. STARKUS, Bangimantas; KITKAUSKAITĖ, Adriana. Office 2000 patogu ir paprasta. Kaunas: 

Smaltija, 1999. 324 p. ISBN 9986-708-41-9. (1). 

11. STARKUS, Bangimantas; KITKAUSKAITĖ, Adriana. Word 2000 jūsų firmoje. Kaunas: Smaltija, 

2000. 303 p. ISBN 9986-965-41-1. (2). 

12. STARKUS, Bangimantas; PASMOKYTĖ, Asta. Excel 2000 ir XP versle. Kaunas: Smaltija, 2002. 

264 p. ISBN 9986-965-77-2. (3). 

13. ŠAKYS, Vigintas. Microsoft Excel 2000 ir 2002. Kaunas: Smaltija, 2002. 550 p.  

ISBN 9986-708-77-X. (3). 

14. VIDŽIŪNAS, Antanas; MICKUS, Artūras, VITKUTĖ, Daiva. Kompiuterinio dokumentų tvarkymo ir 

interneto panaudojimo pavyzdžiai. Kaunas, 2001. 

15. ВЕЙСКАС Д. Эффективная работа с Microsoft Access 2000. Санкт Петербургб 2000. 

16. ДЖОНС Э., ДЖОНС Д. Access 97 книга ответов. Санкт-Петербург: Питер, 1998. 

Parengė dėst. Danguolė Ignatavičiūtė 2003m. Access - 49 


	Kas yra duomenø bazë?
	Access pradþia
	Duomenø bazës kûrimas naudoajnt vedlá \(wizar�
	Naujos tuðèios duomenø bazës kûrimas
	Lentelës laukø parametrai
	Pirminiai raktai ir indeksai
	Lenteliø sàryðiai
	Duomenø ávedimas á lentelæ
	Lentelës struktûros redagavimas
	Lentelës struktûros ir dizaino keitimas áraðø 
	Duomenø rûðiavimas ir filtravimas

	Uþklausos
	Sudëtingas filtravimas
	Uþklausø parengimas
	Dialoginës uþklausos
	Skaièiuojami laukai
	Suvestiniø duomenø uþklausos
	Kryþminiø suvestiniø uþklausos
	Lentelës kûrimo uþklausa
	Lenteliø papildymo uþklausos
	Paðalinimo uþklausa
	Pakeitimø uþklausa

	Formos
	Ataskaitos
	Iðrinkimo laukai

	Duomenø importas ir eksportas
	Sudëtinës formos
	Formos elementø eilës tvarka
	Pradinë forma ir mygtukai

	Savikontrolës klausimai
	LITERATÛRA

